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Qualified Persons
Ç WARNING

The equipment covered by this publication must be installed, operated, and maintained by 
qualified persons who are knowledgeable in the installation, operation, and maintenance 
of overhead electric power distribution equipment along with the associated hazards. 
A qualified person is one who is trained and competent in:

•   The skills and techniques necessary to distinguish exposed live parts from non-
live parts of electrical equipment.

•   The skills and techniques necessary to determine the proper approach distances 
corresponding to the voltages to which the qualifi ed person will be exposed.

•   The proper use of the special  precautionary  techniques,  personal  protective 
equipment, insulating and shielding materials, and insulated tools for working on 
or near exposed energized parts of electrical equipment.
These instructions are intended only for such qualified persons. They are not 

intended to be a substitute for adequate training and experience in safety procedures 
for this type of equipment.

Read this Instruction 
Sheet

Thoroughly and carefully read this instruction sheet before programming, operating, or 
maintaining your S&C Universal Interface Module. Familiarize yourself with the safety 
information on page 3. The latest version of this instruction sheet is available online in 
PDF format at www.sandc.com. Select: Support/Product Literature Library.

Retain this Instruction 
Sheet

This instruction sheet is a permanent part of your S&C IntelliRupter. Designate a location 
where you can easily retrieve and refer to this publication. 

Warranty The standard warranty contained in S&C’s standard conditions of sale, as set forth in 
Price Sheet 150, applies to the Universal Interface Module, except that the first paragraph 
of said warranty is replaced by the following:

(1) General: Seller warrants to immediate purchaser or end user for a period of 10 
years from the date of shipment that the equipment delivered will be of the kind and 
quality specified in the contract description and will be free of defects of workmanship 
and material. Should any failure to conform to this warranty appear under proper and 
normal use within ten years after the date of shipment the seller agrees, upon prompt 
notification thereof and confirmation that the equipment has been stored, installed, oper-
ated, inspected, and maintained in accordance with recommendations of the seller and 
standard industry practice, to correct the nonconformity either by repairing any dam-
aged or defective parts of the equipment or (at seller’s option) by shipment of necessary 
replacement parts. The seller’s warranty does not apply to any equipment that has been 
disassembled, repaired, or altered by anyone other than the seller. This limited warranty 
is granted only to the immediate purchaser or, if the equipment is purchased by a third 
party for installation in third-party equipment, the end user of the equipment. The seller’s 
duty to perform under any warranty may be delayed, at the seller’s sole option, until the 
seller has been paid in full for all goods purchased by the immediate purchaser. No such 
delay shall extend the warranty period.

Replacement parts provided by seller or repairs performed by seller under the war-
ranty for the original equipment will be covered by the above special warranty provision 
for its duration. Replacement parts purchased separately will be covered by the above 
special warranty provision.

Warranty of the Universal Interface Module is contingent upon the installation, configu-
ration, and use of the control or software in accordance with S&C’s applicable instruction 
sheets. This warranty does not apply to major components not of S&C manufacture, such 
as batteries, and communication devices. However, S&C will assign to immediate pur-
chaser or end user all manufacturer’s warranties that apply to such major components.

Introduction
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Understanding
Safety-Alert Messages

There are several types of safety-alert messages which may appear throughout this 
instruction sheet as well as on labels attached to the Universal Interface Module. 
Familiarize yourself with these types of messages and the importance of the various 
signal words, as explained below.

Ç DANGER
“DANGER” identifies the most serious and immediate hazards which will likely 
result in serious personal injury or death if instructions, including recommended 
precautions, are not followed.

Ç WARNING
“WARNING” identifies hazards or unsafe practices which can result in serious 
personal injury or death if instructions, including recommended precautions, are 
not followed.

Ç CAUTION
“CAUTION” identifies hazards or unsafe practices which can result in minor per-
sonal injury or product or property damage if instructions, including recommended 
precautions, are not followed.

NOTICE
“NOTICE” identifies important procedures or requirements that can result in product 
or property damage if instructions are not followed.

Following
Safety Instructions

If you do not understand any portion of this instruction sheet and need assistance, 
contact your nearest S&C Sales Office or S&C Authorized Distributor. Their tele-
phone numbers are listed on S&C’s website www.sandc.com. Or call S&C Headquarters 
at (773) 338-1000; in Canada, call S&C Electric Canada Ltd. at (416) 249-9171.

NOTICE

Read this instruction sheet thoroughly and carefully 
before installing or operating your S&C Universal 
Interface Module.

Replacement 
Instructions and Labels

If  you need addit ional  copies of  this instruction sheet,  contact your 
nearest S&C Sales Office, S&C Authorized Distributor, S&C Headquarters, or S&C Elec-
tric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be replaced 
immediately. Replacement labels are available by contacting your nearest S&C Sales 
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

Safety Information
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Applicable Software These instructions were prepared for use with software UIMD3C1X, Rev. 1.3.

You can find the revision number on the Setup disk label and on the main screen of the UIM, 
called the PRESENT CONDITIONS screen. For questions regarding the applicability of 
information in this chapter to future software releases, please contact S&C.

Ç WARNING
These instructions do NOT replace the need for utility operation standards. Any 
conflict between the information in this document and utility practices should be 
reviewed by appropriate utility personnel and a decision made as to the correct 
procedures to follow.

Serious risk of personal injury or death may result from contact with electric distribu-
tion equipment when electrical isolation and grounding procedures are not followed. 
The equipment described in this document must be operated and maintained by 
qualified persons who are thoroughly trained and understand any hazards that may 
be involved. This document is written only for such qualified persons and is not a 
substitute for adequate training and experience in safety procedures for accessing 
high voltage equipment.

The Universal Interface Module and host control are connected to switchgear operat-
ing at primary voltage levels. High voltage may be present in the wiring to the switch 
control or the switch control itself during certain failures of the switchgear wiring 
or grounding system, or due to a failure of the switch itself. For this reason, access 
to the switch control should be treated with the same safety precautions that would 
be applied when accessing other high voltage lines and equipment. Follow all locally-
approved safety procedures when working on or around this switch control.

Before attempting to access an existing switch installation, check carefully for vis-
ible or audible signs of electrical or physical malfunction (do this before touching 
or operating the switch control or any other part of the installation). These warning 
signs include such things as smoke, fire, open fuses, crackling noises, loud buzzing, 
etc. If a malfunction is suspected, treat all components of the installation, including 
the switch control and associated mounting hardware, as if they were elevated to 
primary (high) voltage.

Whenever you are manually reconfiguring the circuit (for example, during repairs), 
follow your company’s operating procedures to disable automatic operation of the 
IntelliTEAM II system. This prevents any unexpected operation of a team member. 

You can disable the IntelliTEAM II system by pressing the automatic operation 
ENABLE/DISABLE faceplate button to DISABLE on the faceplate of any active 
5800 based team member of the team you want to disable, or turn on Prohibit Res-
toration on the UIM faceplate.

Troubleshooting 
Overview

The following tools and Interface Module features are used to diagnose and correct 
problems.

LCD

The LCD on the faceplate provides information about the present state of the team. For 
an explanation of the faceplate and the LCD, see Instruction Sheet 1043-540.

Troubleshooting Problems
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NOTICE
If the suggested troubleshooting steps do not resolve the problem, call S&C at (773) 
338-1000 for assistance.

Figure 1. Rack-Mounted Universal Interface Module.

LEDs

The LEDs on the Interface Module faceplate provide information about the state of the 
control. For an explanation of the faceplate LEDs, see Instruction Sheet 1043-540.

IntelliLINK software

The OPERATION screens and TROUBLESHOOTING screens display information about 
the Interface Module and its operation. For an explanation of these screens, see Using 
IntelliLINK to Locate Problems on page 9.

To view these screens, you need a portable IBM/PC-compatible computer, a serial cable, and 
the IntelliLINK version for the Interface Module. For more information about the equipment 
required and how to use the IntelliLINK software, see Instruction Sheet 1043-540.

Figure 2. Panel-Mounted Universal Interface Module.

Troubleshooting Problems
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LCD is blank or you cannot scroll the data, or is not lighted

Check the LEDs. If all the Interface Module LEDs are OFF, the Interface Module is not 
receiving power.

Check control power. Following utility-approved work procedures and safety practices, 
verify that there is correct voltage in the line which provides control power.

The IntelliLINK software may display an error message while trying to establish commu-
nications with the Interface Module or a snapshot. If an error message appears, follow the 
corrective action given below for that message.

IntelliLINK software won’t start

A. Close other software programs. Some software applications (such as HotSync® 
technology for Palm™ handhelds) may interfere with the IntelliLINK software being 
able to access your computer’s serial port. You should exit any program that might 
take control of a serial port while using the IntelliLINK software.

B. Reinstall the IntelliLINK software on your computer. There may be a problem 
with one of the fi les. See To Install the IntelliLINK Software in 1043-530.

“Could not connect to control on COM1”

See Opening port COM1... Trying 38400 BAUD... Connection Failed below.

“Incompatible Ident”

The IntelliLINK software uses a different screenset (WMN file) for each type of control and 
normally selects the screenset for you. This message appears when you have a screenset 
selected (displayed) and try to connect to a snapshot that requires a different screenset.

Use the correct screenset. To close the open screenset, click File > Close Screenset. Then 
click File > Open Snapshot. In the Open Controller Data File dialog box, select the snapshot 
you want to view, then click OK to open both the snapshot and the correct screenset. 

“IntelliLINK setup incorrect or incomplete“

Reinstall the IntelliLINK software on your computer. There may be a problem with 
one of the files. See To Start the IntelliLINK Software in 1043-530 for details.

“Opening port COM1... Trying 38400 BAUD... Connection Failed”

These messages appear in the Connect dialog box when the IntelliLINK software in your 
computer cannot establish communication with the software in the Interface Module.

A. Check that the Interface Module has power. If the LCD is blank, the Interface 
Module may have no power and cannot communicate with your portable computer. 
See LCD is blank or you cannot scroll the data on page 7.

B. Check the serial cable connections. Check that you plugged your serial cable 
into the LOCAL COMM. PORT on the Interface Module faceplate. Check that you 
plugged the cable into the correct port on your computer (usually COM1 on portable 
computers).

C. Try another communications port. The COM1 port on your computer may be 
broken or assigned to a different device. Connect the cable to another comm port. 
In the Connect dialog box, click the Change Setup button. From the pull-down list, 
select the name of the port where you connected the cable. Click Connect.

Display Problems

Error Messages

Troubleshooting Problems
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D. Use a different serial cable. The serial cable between your computer and the 
switch control may have a broken wire or pin. The cable may be wired for use with 
a different kind of computer, or it may be a null-modem cable.

E. Check the serial port on your computer. Test the serial port by trying to com-
municate with a modem or other serial device.

“Program in the control: XXXX... not configured for this program”

Reinstall the IntelliLINK software on your computer. Make sure that you are install-
ing the correct IntelliLINK software for this Interface Module. For details, see To Install 

The IntelliLINK Software in 1043-530.

“Software in control incompatible with open screenset... cannot be established”

The IntelliLINK software uses a different screenset (WMN file) for each type of control and 
normally selects the screenset for you. This message appears when you have a screenset 
selected (displayed) and try to connect to a control that requires a different screenset.

Use the correct screenset. To close the open screenset, click File > Close Screenset. Then 
click File > Open Screenset and choose the correct screenset for the Interface Module. 
Once the screenset opens, click Connection > Connect to Device.

“Software in control is XXXX... not properly configured for this product”

Reinstall the Setup software on your computer. There may be a problem with one of 
the files. For details, see To Install The IntelliLINK Software in 1043-530.

“Times New Roman font is not on your system. The project requires it.”

Click OK to close the dialog box. If the program cannot find the desired font, it warns 
you and then uses a different font.

Team Does Not Communicate

 IMPORTANT: Carry out the following general procedure at each member of the team 
– starting at the team member that is the most likely source of the problem.

A. Check the link between the switch control and its team communications 

device. Check that the communications cabling is fi rmly in place at both ends, and 
that the communications device has power. 

B. Check all other communications ports that are being used. If the interface 
module is directly connected to another team member, Interface Module connected 
to host control device, or there is a radio or cable connection to a SCADA master 
station, check all those cable connections. Test communication between the interface 
module and the other devices.

C. Check the SETUP: Communications screen settings. Make sure the baud rates, 
RTS active durations, and duplex settings are correct for the installed communica-
tions hardware. 

D. If this switch control/Interface Module uses a radio, check the radio antenna. 
Check that the radio antenna is in place and that the antenna cable is attached at 
both ends.

E. If this switch control/Interface Module uses a radio, check radio connectiv-

ity. Check that the radio at this location can see all the other radios that it should 
see. For more details, see the manufacturer’s documentation.

Software 
Troubleshooting

Troubleshooting Problems
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Team does not reconfigure the circuit

A. Check the Team Logic setpoint. Connect your computer to the switch control/
Interface Module and start the IntelliLINK software. On the SETUP: Team screen, 
check that the Team Logic setpoint is enabled for this team.

B. Check the other SETUP: Team screen settings. Make sure the DNP/RTU Address 
is correct for each team member. Also, check that the normal switch position in the 
Normal Open/Close setpoint is correct for each switch in the team, and that the 
normal switch function is correct in the Normal Sw Func setpoint. Make sure that 
the Maximum Capacity settings are appropriate for the circuit conditions.

C. Check the values on the TEAM OPERATION screen. Make sure that the Ready 
Status reads READY. If not, check the Operational Status, Line Status, and Con-

fi guration Status fi elds for reasons that the team may not be ready.

D. Check team communications. See Team Does Not Communicate on page 7.

E. Check the circuit confi guration. Make sure that the circuit has not been temporar-
ily reconfi gured due to construction or maintenance.

F. Check whether an event was logged. Check the DATA LOGGING HISTORIC 

EVENTS screen to see whether the switch control detected and took action on an 
event. 

Team does not return the circuit to normal

 A. Check the Return to Norm Mode setpoints. Connect your computer to the  
Universal Interface Module and start the IntelliLINK software. On the SETUP: Team 
screen, check that the “Rtn to Norm Mode” setpoint is set properly for this team (Open 
or Closed).

B. Check the present operation mode for each team member. On the TEAM 

OPERATION screen, make sure that the Ready Status reads READY. If not, check 
the Operational Status, Line Status, and Confi guration Status fi elds for reasons 
that the team may not be ready.

C. Check team communications. See Team does not communicate on page 7.

D. Be sure automatic operation was not disabled. If automatic operation was dis-
abled at any team member while the circuit was in its reconfi gured state, the Return 
to Normal process is canceled.

LCD shows “ALARM” or “FAULT”

 Check the TEAM OPERATION screen. Check the Operational Status, Line Status, 
and Confi guration Status fi elds for the reason(s) that the team is not ready.

DNP communications between PC and team members is not working

A. Check team communications. See Team does not communicate on page 7.

B. Check that the DNP cable is connected. Make sure that the serial cable from your 
computer is connected to the cable from the DNP port (usually Port A). Also check 
that the DB9 connector is fully seated in the DNP port.

C. Check the protocol and DNP address being used by the IntelliLINK software. 
Start the IntelliLINK software on your computer. Select Tools > Options > Communi-
cation Setup. Make sure that DNP is the selected protocol. Also check that the Peer 
Address matches the “DNP/RTU Address” for the team member with which you are 
trying to communicate. Be sure the timeout and the baud rate are set appropriately 
as well.

Troubleshooting Problems
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D. Check for error messages on the HISTORIC EVENT VIEW screen. To perform this 
check, connect directly to the faceplate communications port and select “ICP” in 
the IntelliLINK Communications Setup dialog box. See “HISTORIC EVENT VIEW 
Screen” on page 35 for more details.

SCADA commands are ignored by the Interface Module/Host control device

A. Check for Interface Module power.

B. Check the RTU address. At the SETUP: Communications screen, check 
which Communications RTU Address is used by this switch control. Make sure 
the SCADA master station is sending commands for this control to the correct 
address.

C. Check your communications hardware. See the manufacturer’s documentation 
for details.

The LOCAL OPERATION, TEAM OPERATION, and TROUBLESHOOTING screens 
can help you check the present status of:

• this Universal Interface Module
• other team members
• team operations

These screens can also help you locate the cause of various team and team member 
problems.

Using IntelliLINK to 
Locate Problems

Troubleshooting Problems
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IntelliLINK Menu
Navigation Buttons

The Tree button, at the right of the Main button, opens the Select Screen dialog box, and 
presents an expandable tree view of the UIM Screenset, similar to Windows Explorer. 
Double click on the screen name that you want to go to.

View the Present Conditions Screen

The PRESENT CONDITIONS screen (Figure 3) shows the present status of various switch 
control settings, any existing fault and error conditions.

To display the PRESENT CONDITIONS screen:

Click the Main button at the bottom of any IntelliLINK screen to go to the PRESENT 

CONDITIONS screen.

Navigating the 
IntelliLINK Screens

The Main button, at the bottom of each screen, takes you back to the Present Conditions 
screen, which is the main screen for UIM IntelliLINK Software. From this screen you can 
get to all other screens. You can also return to the Present Conditions screen, by opening 
the Window menu, and selecting Show Main Screen.

Troubleshooting Problems
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Figure 3. PRESENT CONDITIONS Screen.

This screen includes the following fields:

External Device Present Conditions

Switch Position

Once the binary status points are entered for switch position and the Interface Module is 
polling the external device, the present switch position will be displayed here. Anything 
other than open and close will be reported as bad contacts.

Remote Mode

Once the binary status point is entered for remote mode and the Interface Module is 
polling the external device, the state of the remote mode will be displayed here. If not 
programmed an N.A. will be displayed.

Fault Status

This field will follow the phase fault status points. If all points are inactive, Normal will be 
displayed, Fault Detected will be displayed on any or all points that are active.

Error/Trouble Status

Any active alarms out in Data Logging, Logging Status Points will cause the message 
“Problems Present - Check Data Logging Screens”.

Interface Module Present Conditions

Prohibit Restoration

When Prohibit Restoration becomes active from the front panel or from IntelliTEAM II, 
Enabled will be displayed, else Disabled will be displayed.

Troubleshooting Problems
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Auto Operation Status

When IntelliTEAM initiates extended phase loss or 3 phase voltage loss open commands 
to the external device, “Extended voltage loss trip” will be displayed, else “Idle” will be 
displayed.

Interface Module Information

Software Product Name

This is the S&C name for the application software present in this Interface Module.

Product Version

The first two bytes 00.09 are the firmware revision bytes. 00 is the major version with 09 
being the minor version. IntelliLINK uses these two bytes to match the screen set to the 
application version loaded into the Interface Module. The remaining two bytes 00.02 are 
the application build revision.

Product Version Codes

These eight bytes are unique to this firmware/product revision. These codes along with 
the above Product Version are used to identify software installed in the field when trouble-
shooting concerns are being addressed.

EOS Version

The version of the operating system is displayed here.

Interface Module Commands

Clear Manual Switch Operations

When IntelliTEAM II has taken a team out of ready because of a manual operation, or a 
NO OPERATION report was encountered, use this command to clear the internal error.

Troubleshooting Problems
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Figure 4. Communications Diagnostics for the Universal Interface Module.

To display the Communications Diagnostics screen:

From the PRESENT CONDITIONS screen select the Comm Menu button, and click the 
Comm Stats button to display the Communications Diagnostics screen (Figure 4). 

This screen contains counters and statistics associated with DNP communications 
and the IntelliTEAM II system. This page tracks communications statistics for each 
team member in the team(s) where this control is a member. 

RTU Address 

This field shows the “DNP/RTU Address” for the team member associated with the 
counts in the column below. 

Xmit Count 

This field shows the number of original packets transmitted to a single team mem-
ber. 

Retry Count 

This field shows the number of packets transmitted to a single team member due to 
a retry of an original packet. 

Fail Count 

This field shows the number of communications failures with a single team mem-
ber. 

Last 2way 

This field shows the latency (in seconds) associated with the last request sent to a 
single team member. 

Min 2way 

This field shows the minimum latency (in seconds) recorded for a request sent to a 
single team member. 

Communication Diagnosis
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Max 2way 

This field shows the maximum latency (in seconds) recorded for a request sent to a 
single team member. 

Avgd 2way 

This field shows the average latency (in seconds) recorded for requests sent to a 
single team member. 

Last Cleared

A timestamp is displayed here that indicates the last time “Clear All” was performed. 
This timestamp will assist you in determining the usefulness of the counters presented 
on both Various Counters screens. If the counters have not been recently cleared, 
then they may not represent present communications performance.

Figure 5. SETUP: Communications Diagnostics for the Universal Interface Module.

To display the Communications Diagnostics screen:

From the PRESENT CONDITIONS screen select the Comm Menu button, and click the 
Comm Stats button to display the Communications Diagnostics screen, then click “Pg 
Dn”.

This screen contains diagnostic information regarding communications related buffers 
within this control. This information may be useful when talking with S&C personnel 
about communications related issues. 

Transport Function Receive List 

This is the number of DNP frames that have been received and placed in the Transport 
Function frame buffer. A frame may remain in this buffer if it is part of a multi-frame 
fragment for which all frames have yet to be received, or it may remain in this buf-
fer for a limited time if the application layer is busy and can not yet accept the new 
frame. 

Communication Diagnosis



  S&C Instruction Sheet 1043-550  15

Transport Function Transmit List 

This is the number of DNP fragments that have been processed by the application 
layer and are waiting for Data Link Layer service. A fragment may remain in this 
buffer for a limited time if the Data Link Layer is busy. 

Application Layer Message List 

This is the number of application layer messages that are waiting to be processed 
and/or serviced by the Transport Function. These messages primarily consist of 
originated messages destined for team members for which responses are expected. 
These originated messages will remain in the buffer until a response is received or 
until the retry time and count have expired. 

Peer Device List 

This is the number of peer devices, or team members, that have been registered with 
DNP and for which an association will be maintained. 

Special Function List 

This is the number of special functions that have been registered with DNP. Special 
functions are application processes that will be triggered by read or write operations 
to special predefined virtual memory locations. 

URBE Function List 

This is the number of functions, or application processes, that have been registered 
with DNP which will be triggered by the reception of unsolicited event messages 
from specific peer devices. 

Binary Input Point List 

This is the total number of binary input points that may be mapped to SCADA point 
numbers. This is the size of the buffer rather than the actual number of mapped 
points. 

Analog Input Point List

This is the total number of analog input points that may be mapped to SCADA point 
numbers. This is the size of the buffer rather than the actual number of mapped 
points. 

Counter Input Point List 

This is the total number of counter input points that may be mapped to SCADA point 
numbers. This is the size of the buffer rather than the actual number of mapped 
points. 

Control Output Point List

This is the total number of control output points that may be mapped to SCADA 
point numbers. This is the size of the buffer rather than the actual number of mapped 
points. 

Analog Output Point List

This is the total number of analog output points that may be mapped to SCADA point 
numbers. This is the size of the buffer rather than the actual number of mapped 
points. 

Binary Event List

This is the number of binary input events that are queued and ready to be sent in the 
next event data request, or the next unsolicited event report. 

Analog Event List

This is the number of analog input events that are queued and ready to be sent in the 
next event data request, or the next unsolicited event report. 

Communication Diagnosis
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Counter Event List 

This is the number of counter input events that are queued and ready to be sent in 
the next event data request, or the next unsolicited event report. 

Route Table List 

This is the number of routing table entries that have been registered with DNP. These 
entries originate from the “SETUP: Communications Routing” screen. 

Troubleshooting Problems



  S&C Instruction Sheet 1043-550  17

Team Operation Screens The TEAM OPERATION screens show the present status of various team-related param-
eters for all members of the team.

To display the TEAM OPERATION MENU screen:

Click the Team Menu Button from the PRESENT CONDITIONS screen.

Figure 6. TEAM OPERATION MENU Screen.

The TEAM OPERATION MENU screen (Figure 6) shows a summary of the DNP/RTU 
addresses for the teams where the Universal Interface Module is a member, and the pres-
ent Ready Status of each of the active teams.

To display one of the TEAM OPERATION screens:

At the TEAM OPERATION MENU screen, click the OPER button for the team you want to 
access. The IntelliLINK software will display Page 1 of the corresponding TEAM OPERA-

TION screen.

Team Problems



18  S&C Instruction Sheet 1043-550 

Figure 7. Page 1 of the TEAM OPERATION Screen.

Page 1 of the TEAM OPERATION screen (Figure 5) shows the present status of various 
team-related parameters and information for each team member.

Team ID

This is the name you entered in the Team ID setpoint on the SETUP: Team screen.

Ready Status

If the Operational Status, Line Segment Status, and Configuration Status all indicate that 
no errors are present, READY appears in this field. If errors are present, ALARM appears. 
FAULT will be displayed if the team is isolating a faulted line segment.
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Operational Status

This is the operational status of the system. When the team members can perform team 
operations, this field reads Good. Other Possible values are:

Coordination The team coach is not being passed throughout the team, 
causing a lack of team coordination.

Remote Config The configuration of an adjacent team member is not consis-
tent with the local team member’s configuration.

Local Config There has been a change to the local team configuration on 
the SETUP: Team screen that has not yet been accepted.

Remote Error An adjacent team member is indicating an error condition.

Local Error The local switch is disabled because Prohibit Restoration is 
ON, or because the switch has changed state from a faceplate 
or SCADA operation.

Logic Disabled The team logic has been disabled on the SETUP: Team 
screen.

Not In Use This team is not in use.

No 2nd Contin. The team is in a transferred state, but if an additional event 
occurs, no further transfer is allowed.

Configuration Status

This is the status of the user configuration parameters essential for team operation. Pos-
sible values are:

NoRTU Addr No RTU address was specified on the SETUP: Communica-

tions screen.

Stop + Data Chg The “Team Setup” setpoint is in a “Stopped” state follow-
ing a change made to the team parameters on the SETUP: 

Team screen.

Stopped The “Team Setup” setpoint is disabled on the SETUP: Team 
screen.

Data Change An unexpected change has been made to the team param-
eters on the SETUP: Team screen.

Record Count The count of team member records on the SETUP: Team 
screen is incorrect. The team database must have at least 
one record to be valid.

Not 1 Source An incorrect number of source switches was configured on 
the SETUP: Team screen. A team may have one and only 
one source switch.

No Local Rec No local record was found in the team database. One of the 
team records must contain an RTU address that matches the 
“DNP/RTU Address” entered on the SETUP: Communica-

tions screen.
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Line Segment Status

This is the fault and voltage loss status of the line segment protected by this team of con-
trols. If no fault or voltage loss is detected, this field reads “Good.” The field can include 
a combination of possible values:

Segment Dead (Dd) The line segment is deenergized.

Segment Open (Op) All team switches are in the open position in preparation for 
a circuit reconfiguration.

Overcurrent (OC) An overcurrent fault has been detected on the line segment 
protected by this team of controls.

Voltage Loss (VL) A voltage loss event has been detected on this line segment 
before this transfer event occurred.

Team Error (Er) An error has been detected within the team, affecting the 
accuracy of the “Line Segment Status.”

Alt Source (AS) The line segment is being fed by an alternate source, either 
directly from an adjacent line segment, or indirectly from 
another location.

Local Real-Time Load

This is the 2-minute averaged measured 3-phase load (in amps) on the line segment pro-
tected by this team. This averaged load does not include the load measured beyond any 
of the switches serving load outside of the local line segment.

Real Capacity

This is the loading capacity available on the line segment protected by this team. This value 
takes into account the real capacity of any source-side teams, the maximum capacity of 
the team’s present source switch, and any load that has already been transferred during 
team circuit reconfiguration.
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Transfer State

This is the present state of any transfer operations. When no transfer or Return-to-Normal 
process is in effect, this field reads Idle. Possible values are:

Idle The team configuration is normal, and no transfer or Return-
to-Normal operation is taking place.

Init The first step of a transfer event, where data is quickly col-
lected from all team members, is taking place.

Rqst The stage of the transfer event when the line segment is 
requesting service restoration from an adjacent line segment 
is taking place.

Grant The stage of the transfer event when the line segment has 
been asked to grant service restoration to an adjacent line 
segment is taking place.

Wait The team is not in a normal configuration, and is waiting for 
additional circuit reconfiguration or return-to-normal.

RTN The team is actively returning to a normal configuration.

Stop An error has been indicated either locally or remotely, caus-
ing a stop transfer condition.

Fault This is a special transfer state that is used by a team that is 
presently isolating a fault.

Hold This transfer state will be active when the team has 
begun a transfer event, but the line segment is not yet 
fully deenergized, requiring further transfer activity to be 
delayed.

These fields apply to the individual team members in this team.

DNP/RTU Addr

This row shows the DNP/RTU address for each team member. You entered this informa-
tion on the SETUP: Team screen for this team.

Sw/Pos Num

This row shows the switch/position number associated with the team member, for example 
“Sw1” for a single overhead switch. You entered this information on the SETUP: Team 
screen for this team.

Normal State

This row shows the state of each line switch when the circuit is configured normally. You 
entered this information on the SETUP: Team screen for this team.

Individual Team Member 
Status
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Present State

This is the present position of each switch in the team:

Open The switch is open.

Closed The switch is closed.

---- The switch state is unknown, or the record is not in use. This 
is the initial state of all switches and is considered an error 
condition during normal operation.

Auto Mode

This field shows the automatic features enabled for each team member. You entered this 
information for each team member on the SETUP: Automatic Operation and SETUP: 

Team screens. It also indicated whether the switch control has been temporarily placed 
in manual operation mode. The field can include a combination of possible values:

M The switch control has been temporarily placed in manual 
mode via the faceplate or SCADA command.

A Automatic sectionalizing has been enabled with the features 
configured on the SETUP: Automatic Operation screen.

V Sectionalizing on loss-of-voltage only is enabled.

T Automatic transfer logic has been enabled on the SETUP: 

Team screen.

Ro Return-to-Normal logic using an open transition has been 
enabled on the SETUP: Team screen.

Rc Return-to-Normal logic using a closed transition has been 
enabled on the SETUP: Team screen.
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Internal Error

This field reads None when no internal errors are present in a team member. Possible 
error values are:

Trouble The switch is disabled because of a bad battery or other 
condition.

NotAuto The switch has been placed into a non-automatic condi-
tion.

ManOR The switch’s open/close state has been manually overridden 
by either a faceplate or SCADA operation.

No Op The switch has detected an error in operation following a 
transfer event. A close or open operation was requested, but 
either the team member was unable to perform the operation, 
or the switch tripped back open based on shots-to-lockout 
logic (close request only).

NOTE: ManOR and No Op status can be cleared on the 
PRESENT CONDITIONS screen using the Clear Manual 

Switch Operations Clear command. They can also be 
cleared on the Team Sw. Errors screen of the LCD, or with 
a SCADA command.

ProRes The switch has been sent a Prohibit Restoration com-
mand.

Event Status

This is the present status of events related to this team member. The field can include a 
combination of possible values:

O Latched overcurrent event.

V Latched voltage loss, any or all phases

P Latched phase loss sectionalizing event

Vr Real-time voltage loss, any phase

3Vr 3-phase real-time voltage loss

Avg Load

This is the 2-minute averaged 3-phase load reported by each individual team member. 
This value is used when determining the Local Real-Time Load. Following a circuit event, 
this value is frozen at the last value reported before the event began; this insures that the 
team uses pre-event values during the transfer. The value is not updated until after the 
transfer.

Rev Current

This field reads Active when a team member senses reverse current.
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To display Page 2 of the TEAM OPERATION screen:

Click the PgDn button at Page 1 of the screen.

Figure 8. Page 2 of the TEAM OPERATION Screen.

Page 2 of the TEAM OPERATION screen (Figure 6) shows the present status of various 
team-related parameters and information for each team member. 

The upper part of this screen displays information that is the same for all members of 
the team.

Coach ID

This field identifies the presently active coach. If a coach is lost, the next coach generated 
uses an identification sequence greater than the present number.

Coach Present

This field indicates that the team coach is present at this team member, as well as showing 
the status of the coach:

Reborn The coach is newly generated.

Seeking BC The new coach is looking for the most recent copy of team 
data.

Mature The coach contains the valid team data and is able to facili-
tate normal team functions.
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Coach Counter

This is the ongoing count of times the present coach has arrived at team members. Along 
with the Coach ID, it is used to validate the coach when it is received.

Coach Flags

This is an indication used by various functions within the team member to note that the 
coach has arrived and left this team member. It indicates that the team data has been 
refreshed.

Coach Sw Rec

This field shows the switch record where the coach, if present at this team member, is 
executing.

Team Visit Time

This field indicates the number of seconds remaining in which the team member expects 
the coach to return. This timer is refreshed while the coach is present. If the coach does 
not return, and the timer expires, this team member will generate a new coach.

Crumb Trail

This field holds a team database record as a marker to allow team functions to span mul-
tiple teams and have a path back to the originating team.

RTN Activity

This field shows the team database record where the Return to Normal process origi-
nated.

Present Source

This field shows the team database record for the switch through which the line segment 
is presently receiving power.

Segment Limit

This is the number of line segments that are allowed to be restored on this circuit. It is 
the lesser of the limit configured in the Line Segment Limit setpoint on the TEAM: Setup 
screen and the limits set in adjacent source side teams.

Extended Load

This is the extended loading of the team, which includes the loading of the line segment 
and all downstream load.

Local RT Load

This field displays the local real-time load on the line segment protected by this team. It is 
the same as the Local Real-Time Load on Page 1 of the TEAM OPERATION screen.

Local Capacity

This is the loading capacity of the local team. This value is compared with the remote 
capacity of the adjacent source side team to determine the real capacity of the team.

Real Capacity

This field shows the loading capacity available on the line segment protected by this team. 
It is the same as the Real Capacity on Page 1 of the TEAM OPERATION screen.

Segments Added

This field shows the number of segments presently added. The team compares this value 
to the Line Segment Limit on the SETUP: Team screen when a transfer event occurs.
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The center part of the screen contains a table of the team tasks that are presently being 
executed. This information is used for diagnostic purposes when working with S&C sup-
port engineers.

TaskID

This is the identification for the task to be executed.

TaskOwn

This is the team database record where this task is to be executed. The task may also 
require global execution at all team members.

TaskSeq

This is the sequence number of the executing task.

TaskTTR

This is the Time-to-Run of the executing task.

The lower part of the screen contains a table of information (database records) about all 
members of the team.

Visit Timer

This is the countdown timer for the next time the coach should visit a specific team 
member. These timers are carried by the coach, and will be decremented only while the 
coach is present.

Event Sequence

This is the sequence number of the last event received from this team member.
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Team Member Task 
Operations

Figure 9. Team Member Task Operation Screen.

The MISC OPERATION: Team Member Task Operation screen (Figure 9) shows a table 
of the team member tasks that are presently being executed. This information is used for 
diagnostic purposes when working with S&C support engineers.

This screen includes the following fields:

ID

This is the identification for the task to be executed.

Own

This is the team database record associated with the execution of this task.

Seq

This is the sequence number of the executing task.

TTR

This is the Time-to-Run of the executing task.

Attrib

This is the Lock and Execute attributes associated with the executing task.

TEAM

This is the team number associated with the execution of this task.

To display the Team Member Task Operation screen:

Click the Operation button at any IntelliLINK screen, then click Misc Operation and then 
the Member Tasks buttons.
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The MISC OPERATION: Contract Status screen (Figure 8) shows information about 
contracts associated with the contract agent at this control. This information is used for 
diagnostic purposes when working with S&C support engineers.

If a contract is required for a particular line segment, a contract agent is used to track and 
secure the contract. Every contract request is uniquely identified by the requesting agent, 
the originating segment, and the timestamp when the request was made.

To display the Contracts screen:

Click the Operation button at any IntelliLINK screen, then click Misc Operation and then 
the Contract Status buttons.

Figure 10. Contract Status Screen.

Contract Status

This screen includes the following fields:
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Contract State

This field shows the present state of the contract:

Active The contract has been granted and is presently active.

Rqst unsent The contract agent received a contract request from the 
team member, but has not yet sent the request to the next 
contract agent.

Rqst pending The contract request is pending.

Rqst travel The contract agent is forwarding the contract further; the 
decision whether to grant the contract cannot be made at 
this location.

Rqst accept The contract request was accepted by this agent; the contract 
approval is headed back to the originating agent. When this 
message appears at the granting agent, the contract has 
been approved.

Rqst decline The contract request was declined by this agent. The request 
will be sent back to the originating agent.

Decline cont. A “declined” message is being passed along to the request-
ing agent.

Dissolve start An agent is dissolving the contract. This is generally done 
by the requesting agent.

Dissolve cont. A “dissolve” message is being passed along.

Maint start The maintenance timer on an active contract has expired, 
causing a maintenance action to occur.

Maint tickle This contract agent has not seen a maintenance message 
for the contract lately. The agent sends a reminder to the 
requesting agent to see if the contract is still needed.

Maint travel A maintenance message is being passed from the requesting 
agent to other agents along the contract route.

Maint tra NF The contract agent has received a maintenance message for 
a contract that is not found in its list.

Maint tra NF rt A Maint tra NF message (see above) is being returned to 
the requesting agent. This message can also appear at other 
agents along the contract route.

Maint tic NF The contract agent has received a tickle message for a con-
tract that is not found in its list.

Maint tic NF rt A Maint tic NF message (see above) is being returned to the 
agent that initiated the tickle. This message can also appear 
at other agents along the contract route.

Maint restart The requesting agent has confirmed that it still needs the 
contract. The maintenance timer is restarted.

Maint res cont. A restart message is being passed to other agents along the 
contract route.
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Rqst Agent

This field shows which agent requested the contract.

Grant Agent

This field shows which agent approved the contract.

Orig Segmt

This field shows the team record number for the segment where the contract request 
originated.

Temp Segmt

This field shows the present team record number for the location of the contract 
request.

Line Count

This field shows how many line segments will be picked up if the contract request is 
granted. This value is generally “1.”

Load Rqst

This field shows how much load will be picked up if the contract request is granted.

Maint Timer

Once a request is granted, this field shows the time remaining before contract maintenance 
should be performed. Normally, when a contract is no longer needed, the requesting agent 
sends a message to dissolve the contract. However, if the local contract agent does not hear 
anything within the Maint timer, it checks with the requesting agent. The requesting agent 
can then extend the contract if it is still needed, or dissolve the contract if it is not. 

Rqst Time

This is the date and time when the contract was requested.  
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Team Member Action 
Path

The Team Member Action Path screen (Figure 9) shows a table of the actions taken dur-
ing the execution of a switch operation. This information is used for diagnostic purposes 
when working with S&C support engineers. 

Some switch gear require different steps to be taken during the operation of the switch 
than other gear. These steps are often further changed by the configuration of switch 
parameters, the team parameters, and the conditions of the event. Together the steps are 
called the Action Path. The Action Path displayed in this table is created on the fly based 
on the present conditions during each event.

Due to the complexity of some Action Paths it is necessary to have the ability to back out 
of a series of steps. Backing out of an Action Path may occur when one of the steps can 
not be performed, thus requiring that the switch be put back into its normal state.

To display the Action Path screen:

Click the Operation button at any IntelliLINK screen, then click Misc Operation and then 
the Action Path buttons.

Figure 11. Team Member Action Path Screen.

This screen includes the following information:

Direction

This is the Forward or Reverse direction that the Action Path is presently taking. Reverse 
will only occur if the forward path is stopped before completion.

Action Item Pointer

For diagnostic purposes only, when working with S&C support engineers. This indicates 
the record within the Action Path that is presently being executed.
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Forward Action / Reverse Action

These columns display two pieces of information. One is the name of the step what will 
be taken during execution of the Action Path. The other is a timestamp associated with 
the start of that step. The list names that will be displayed are:

 Action path done

 Close for xfer

 Contract request

 Contract terminate

 Block recloser

 Unblock recloser

 Block ground trip

 Unblock ground trip

 Alternate settings

 Normal settings

Status

These columns display two pieces of information. One is the status of the associated step 
in the action path. The status can be Idle, Running, Failed, or Success.
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Coach Activity The Coach Activity screen (Figure 12) shows timestamps for basic coach activities, as 
well as the counter for each team’s coach.

To display the Coach Activity screen:

Start from the PRESENT CONDITIONS screen, click the Team Menu button, then click 
the Operation Menu button, then the Misc Operation Button, and finally the Coach Activ-
ity button.

Figure 12. Coach Activity Screen.

This screen includes the following fields:

Number

This field shows the coach/team number.

Activity

This field shows the coach activity: signing in or going to the specified team member 
(“Rec 1,” “Rec 2,” etc.).

Time...Msec

This is the date and time when the activity occurred.

Sign-In Count

These fields show the ongoing counts for each team’s coach.
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Data Logging Setup

Figure 13. Data Logging Setup Screen.

This screen includes the following fields:

General Settings (for the UIM Historic Log, and enabling the Compact Flash):

Logging Level

Each historic logging event that is generated by the UIM application is assigned one of three 
levels. The assignment is done by S&C. There are three levels supported: All (events useful 
for detailed troubleshooting), Extended (events that allow more in-depth monitoring of 
the application activity) and Normal (events that describe regular operation). The default 
Logging Level is Normal, which tells Data Logging to log only the more basic events.

Normal: Logs only typical user-oriented information.

Extended: Logs both user-oriented information and internal errors.

All: Logs user-oriented information, internal errors, and internal trace/
 debugging information.

Dup. Event Margin (millisec)

Sometimes the UIM application will generate identical historic events within a short amount 
of time. Such “duplicate” events occurring right next to one another may flood the log, 
without yielding much valuable information about the operation of the application. For 
two events to be considered duplicates every element of their event records must match, 

The Data Logging Setup screen (Figure 11) is used to select data that will be stored in the 
UIM internal memory. Only the data you filter for storage can be displayed on the Historic 

Events View screen. If you enable CF Logging, all data will be timestamped and stored on 
the compact flash, without any filtering applied.

To display the Data Logging Setup screen:

Click the Data Logging button on the PRESENT CONDITIONS screen.
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except for the timestamps. This setpoint tells Data Logging to log only the first event in 
an uninterrupted sequence of duplicate events, as long as each subsequent event occurs 
within the margin. 

This setpoint has no effect on alternating sequences of events. For example, the setpoint 
can be set to 10ms and we can have a sequence of events ABABAB (where A and B are 
different events), each next event coming 1ms after the previous one. Even though identi-
cal events occur within 2ms in this case, which is well within the value of the setpoint, all 
of them will be logged-- only an event that is identical to the previously logged one can be 
considered for elimination based on the setpoint.

Halt Hist. Logging When Full

When set to Enabled, halts logging of historic events once the historic event log fills up so 
that all events that come after that are discarded, without overwriting existing contents of 
the log. Compact Flash Logging, Status Point Logging and Special Event Counter logging 
are not affected by this setpoint. This setpoint can only be useful in a troubleshooting 
situation. 

NOTE: Do not set to Enabled, unless there is some particular condition you are trying to 
troubleshoot. Once troubleshooting is complete or new event data is desired, the setpoint 
must be manually set to Disabled to ensure continued event logging.

CF Logging Enabled

When set to Enabled, every single historic event that the application generates will be writ-
ten to the Compact Flash card, if it is present. If the card is not present and the setpoint 
is set to Enabled an error message will be entered in the Historic Event Log each time 
Compact Flash access is attempted. 

Logging Level and Duplicate Event Elimination Margin setpoints do not affect whether 
an event makes it to Compact Flash. The purpose of Compact Flash Logging is to always 
save as much logging data as possible. 

The only way to view Compact Flash logs is to physically remove the card from the control, 
insert it into the CF card reader on a PC, open the desired file with IntelliLINK as a snap-
shot, and view it in HTML format using the Data->Event/Data Logs menu. The procedure 
for viewing the Compact Flash logs is described on page 72.

NOTE: It is strongly recommended that whenever CF card is present, Compact Flash Log-
ging is enabled to make future diagnostics and possible troubleshooting easier.

Ç NOTICE
Do not remove the CF card from the UIM control, unless this setpoint is set to Disabled 
as this can cause CF card corruption. Compact Flash Logging can be disabled either 
by setting this setpoint to Disabled via IntelliLINK or via the control’s keypad.

General Management:

These options apply to event logging in general.

Stop Historic Logging

Stops Historic Event Logging immediately, without affecting Compact Flash Logging, Status 
Point Logging or Special Event Counter logging. All future historic events will not be put 
into historic event log. This can be useful to prevent newer events from overwriting older 
ones when Historic Event Log fills up.

NOTE:  Be sure to start historic logging again once you have collected any necessary data 
from the log so that future events are not lost.
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Clear Status Counters

Clears counters and Last Active/Cleared timestamps for all Status Points contained on the 
Status Points Screen. The time of last clearing is updated both in the lower portion of the 
current screen and on the Status Points screens. 

Clear Special Event Counters

Clears counters and Last/First Active timestamps for all Event counters contained on the 
Special Event Counters Screen. The time of the last clearing is updated both in the lower 
portion of the current screen and on the Special Event Counters Screens.

Clear Historic Log

Removes all events contained in Historic Event Log, but has no effect on Compact Flash 
Logging, Status Point Logging or Special Event Counters logging. The time of the last 
clearing is updated in the lower portion of the current screen.

Ç WARNING
Event data will be permanently deleted from the Historic Event Log.  If you need 
to preserve event data, be sure to generate an HTML report of logged data before 
clearing.  See Historic Event Log, on page 71, for information about generating an 
HTML report

Historic View, Management
It is not possible to view the in-memory Historic Event Log in its entirety via IntelliLINK 
screenset. In its complete form it can only be viewed in HTML format, using the IntelliLINK 
Data->Event Data Logs menu, as described in the Historic Event Log section, on page 71. 
However, a small subset of the full Historic Event Log, referred to as “Historic Event View”, 
is available through the Historic Events screens, as described below. This small subset holds 
only 160 events, as opposed to over 4,000 in the complete Historic Event Log. The following 
features of the screen allow selecting historic events for the Historic Event View. 

NOTE: The settings/commands below have no effect on the main Historic Event Log.

View Mode (Real Time/Static)

Historic Event View can be in one of these two modes: 

“Real Time”

As long as Historic Logging is active, every event generated by the application that 
satisfies the Logging Level and Duplicate Event Elimination Margin setpoints, as 
well as the Categories To Show selection (see below), will be added to the Historic 
Event View as soon as it is generated. When Historic Event View fills up the event slot 
containing the oldest event, is reused. Therefore, in this mode Historic Event View is 
a circular buffer that has no fixed beginning, and is updated in real-time. 

“Static”

Historic Event View is not updated in real-time, but only when either Refill Historic 
View or Chronological Browsing features are used (see below). In this mode the View 
serves as a buffer to output the events that result from queries to the Historic Event 
Log but does not show newest historic events as they arrive. 

 Clear Historic View

Empties Historic View. If View Mode is Real Time, the next qualifying event will be placed 
on top of the View; if View Mode is Static, the View will remain empty until it is refilled or 
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Chronological Browsing features are used.

Refill Historic View

Clears the current contents of the View and loads as many events from the main Historic 
Event Log as the View can hold, in ascending chronological order. Only those events that 
satisfy the Categories to Show selection are placed into the View. Of all applicable events 
the newest are selected. 

Historic View, Categories to Show

Each historic logging event, generated by the UIM, is assigned to one category by S&C, 
based on what part of application’s functionality it belongs to. This is done to ease filter-
ing and sorting. Category assignment is described in greater detail in the Historic Events 
section. 

This feature allows you to select which categories of events will be displayed in the His-
toric Event View. For example, if you want to view only IntelliTEAM-related events, set 
the “ITII” category to “Show” and all other categories to “Hide”. 

ITII  - IntelliTEAM Messages

DNP  - DNP Comm Messages

UIM  - Messages describing the interaction between the UIM and External
    Device

LOG  - Maintenance Messages

Note that enabling and disabling categories does not cause events to be accepted or dis-
carded for placement into the main Historic Event Log, the feature solely applies to the 
Historic Event View buffer. In the same way that the category of the event is ignored for 
the purposes of placing it into the Historic Event Log, the Logging Level of the event (see 
above) is ignored for the purpose of loading it from the Historic Log to the Historic View. 
Therefore, if Logging Level was lowered recently so that Historic Log still contains events 
that would not be logged after the change, Historic View may also end up having these 
events, even though their level does not match the present Logging Level setpoint value. 

Chronological Browsing (static mode only, no refill):

Since the size of Historic Event View is only a fraction of that of the main Historic Event 
Log, it is necessary to be able to navigate through the Log chronologically. This can be 
accomplished in two ways, using these two features:

NOTE: Chronological Browsing features are only taken into account when View Mode is 
Static and do not apply in Real Time mode.

Search By TIme

Loads into Historic Event View up to 160 (size of the View) events that occurred at and 
immediately following a certain time.  Only events that satisfy the Categories To Show 
selection are placed into the View.

If all events that are currently in the main Historic Event Log occurred before or after the 
time specified here, the oldest available events are selected for placement into Historic 
Event View.

Historic Event View is refilled as soon as the timestamp is entered; the timestamp is cleared 
once the refill is complete, to avoid confusion.
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Browse By Page

Allows to browse through Historic Event Log,  instructing the application to load a certain 
group of events into Historic Event View. Four selections are available:

Oldest 8 Pages Loads up to 160 (size of Historic Event View)  of the oldest 
qualifying events from Historic Event Log.

Newest 8 Pages Loads up to 160 of the newest qualifying events from Historic 
Event Log.

Prev 8 Pages Loads up to 160 previous events, relative to the events cur-
rently in the View.  Usually this means older events.

Next 8 Pages Loads up to 160 next events, relative to the events currently 
in the View. Usually this means newer events.

When one of these selections is made, Historic Event View is refilled immediately.

NOTE: Since Historic Event Log is circular, selecting Prev may cause the newest events 
to be displayed (if the View currently holds the oldest) and selecting Next may cause the 
oldest events to be displayed (if the View currently holds the newest).

Last Status Reset Time

This is the time data on the Logging Status Points screen was last reset. The Reset Status 
Points command is located at the bottom of that screen, and in the General Management 
section of the Data Logging Setup screen.

Last Special Event Reset Time

This is the time data on the Special Event Counters screen was last reset. The Reset Special 
Counters command is located at the bottom of the Special Event Counters screen, and in 
the General Management section of the Data Logging Setup screen.

Last Historic Log Clear Time

This is the time the Historic Log was last cleared. The clear command is located in the 
General Management section of the Data Logging Setup screen.
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Historic Event View

Figure 14. Historic Event View Screen.

These screens display Historic Event View—a subset of the Historic Event Log, filtered 
based on the criteria specified in the right portion of the Logging Setup screen. Historic 
Event View holds 160 events and is displayed on 8 screens, 20 events on each. Navigating 
between the View screens is accomplished by Page Up/Page Down buttons in the lower 
right corner.

NOTE: These screens do not show the whole event log, only the filtered portion. To view 
the whole Event Log that resides in memory, use the HTML log feature of IntelliLINK, as 
described in the Historic Event Log section on page 71. Compact Flash event logs can-
not be viewed from these screens either, but can be accessed through the HTML logs, as 
described in the Compact Flash Logging section on page 72.

The Historic Event View screen (Figure 12) shows a chronological listing of events. 
The event message, in conjunction with the Data 1 through Data 4 code, describes the 
event and action(s) taken. There are three categories of messages you can set - Normal, 
Extended, and All - based on the filter you choose, with the Logging Level on the Data 

Logging Setup screen.

If an event message refers only to “Data 1”, then any value in the other data columns is 
diagnostic information used by S&C staff.

The log can hold eight pages of information. In Real-time Mode, once the log is full, each 
new event over-writes the oldest event in the log. To find the most recent event, look for 
the message with a timestamp that is older than the time for the message above it.

To display the Historic Event View screen:

Click the Data Logging button on the PRESENT CONDITIONS screen, and then click the 
Historic Events button.
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Each historic event message consists of these components, all having a corresponding 
column in the Event View table:

Category

Each historic logging event, generated by the UIM, is assigned to one category by S&C, 
based on what part of application’s functionality it belongs to. This is done to ease filtering 
and sorting, as well as allow viewing only events of desired categories on these screens. 
The currently supported categories are: 

ITII Events related to IntelliTEAM II team maintenance and transfer activity

UIM Events related to the interaction with Host Device

DNP Events specific to DNP communications, both between IntelliTEAM II team
 members and UIM to External Device

LOG  Events generated by Data Logging itself, for instance Compact Flash-related

 

Event Description

There are a fixed number of historic logging events in each category, each generated in 
certain cases. This column succinctly summarizes what the event is. The list of all pos-
sible events is below.

Timestamp

Specifies when the historic event occurred, with millisecond precision. Note that this time 
is set based on the control’s clock, not your PC’s. Also, clocks on different controls are 
not automatically synchronized, so events that occurred on different controls at the same 
time might still have different timestamps. If you want to chronologically sort events that 
occurred on different controls, you first need to manually synchronize all control clocks, 
either through SCADA or the External Device Menu / SETUP: Miscellaneous screen. You 
can also synchronize a control with the clock in your PC computer, or manually set the 
time using IntelliLINK. Go to Tools > Set Control Clock on the IntelliLINK screen menu.

Events in the Event View are always sorted by timestamp in the ascending order (older 
to newer). However, because the View is circular when in Real-Time mode, the oldest 
event is usually not on top but rather drifts down as newer events continuously overwrite 
older ones. 

Data1—Data 4

Many events have, together with the timestamp and the description, some numerical data 
associated with them. For example, if a switch was successfully closed in the course of 
IntelliTEAM transfer activity, the number of the team for which transfer took place, is sup-
plied in the Data 1 column. There are up to 4 such pieces of data that can potentially come 
with an event, each placed in one of these 4 columns, always starting with Data1. 

Some event messages contain text in parenthesis, which summarizes the meaning of the 
associated DataX columns, such as: “Transfer Approved (team, code)”. This notation 
means that Data 1 is the team number, Data 2 is approval code and Data 3/Data 4 are either 
unused or contain solely tracing information. Other event messages have supplementary 
data codes that are solely documented below.
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Here is the list of all events, grouped by Category and Event Description:

Category      Event Description      Definition Log Level

DNP Cold restart requested (Source 
Address, Destination Address, 
N/A, N/A)

A cold restart of the control has been requested over SCADA, 
and will be performed in two seconds.

Normal

DNP Configuration change accepted Changes to the communications setup parameters were 
validated and have been made active within the application.

Normal

DNP DNP Initialization complete Displayed when initialization of DNP processes has completed 
without error.

Normal

DNP Error in configuration data (Setup 
Value, Min Value, Max Value, 
N/A)

A configuration setup parameter was found to be set 
incorrectly or out of range.

Normal

DNP Map change callback init error A DNP point map change callback function was unable 
to be registered due to a full callback list.  This prevented 
initialization of DNP processes from being completed.

Normal

DNP Master record not added (Return 
Code 1=error 3=list full, Code 
Location, N/A, N/A)

The master record was unable to be added to the peer device 
list due to either an incorrect parameter or the peer device list 
is full.

Normal

DNP Old configuration remains in 
effect

Indicates that due to an error in configuration data the existing 
setup will continue to be used by the application.

Normal

DNP Pass-through routing disabled A valid pass-through route configuration was not found and 
pass-through routing was disabled.

Normal

DNP Pass-through routing enabled A valid pass-through route configuration was found and pass-
through routing was enabled.

Normal

DNP Point map init error The point mapping table was unable to be initialized, 
preventing initialization of DNP processes from being 
completed.

Normal

DNP Point map reinitialized (Map 
Number, N/A, N/A, N/A)

The point map was successfully reinitialized following 
completion of changes to the point map configuration.

Normal

DNP Route table init error The routing table was unable to be initialized, preventing 
initialization of DNP processes from being completed.

Normal

DNP Route table initialized (Count of 
Routes, N/A, N/A, N/A)

The route table was successfully initialized with configured 
routes and routing was enabled.

Normal
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Category      Event Description      Definition Log Level

DNP Serial port reset error (Port 
Number 1 [1=port a, 2=port B, 
3=port C, 4=port D])

An error occurred in reset of a serial port during a 
communications setpoint configuration change. Changes to 
serial port configuration may not have taken affect.

Normal

DNP Analog output code not mapped 
(Point Code, Associated RTU 
Address, N/A, N/A)

An analog output point special function was not added to the 
list because the analog output point is not yet included in the 
point mapping configuration.

Extended

DNP Analog output function registered 
(Point Code, Associated RTU 
Address, N/A, N/A)

An analog output point special function was successfully added 
to the list.  This function connects an analog output operation 
with functionality elsewhere in the application.

Extended

DNP Bad amount of data received 
(Source Address, Reported 
Length, Actual Length, N/A)

The application layer detected an inconsistency in the amount 
of data in the fragment.  The fragment was discarded.

Extended

DNP Bad fragment length received 
(Fragment Length, N/A, N/A, 
N/A)

The application layer detected a fragment with an invalid 
length.  The valid rand is from 2 to 2048 bytes.  The fragment 
was discarded.

Extended

DNP Bad frame length (Actual Length, 
Indicated Length, N/A, Code 
Location)

The actual length of the received DNP frame does not match 
the length indicated in the DNP data link header.  The frame is 
discarded.

Extended

DNP Bad object range index (Source 
Address, First Index or Index 
Size, Last Index or Qualifier, 
Code Location)

An error was detected in an object header of the current request 
message related to the data index values.  An attempt will be 
made to process other objects within the message.

Extended

DNP Bad transmit fragment length 
(Fragment Length, N/A, N/A, 
N/A)

The application layer was requested to send a fragment larger 
than the 2k size limitation.

Extended

DNP Bad transport segment length 
(Segment Length, N/A, N/A, N/A)

The transport segment length of the DNP frame is invalid.  The 
frame was discarded.  The valid range is from 3 to 250.

Extended

DNP Control point code not mapped 
(Point Code, Associated RTU 
Address, N/A, N/A)

A control point special function was not added to the list 
because the control point is not yet included in the point 
mapping configuration.

Extended

DNP Control point function registered 
(Point Code, Associated RTU 
Address, N/A, N/A)

A control point special function was successfully added to 
the list.  This function connects a control operation with 
functionality elsewhere in the application.

Extended
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Category      Event Description      Definition Log Level

DNP Duplicate fragment received 
(Source Address, Destination 
Address, Application Control, 
N/A)

The application layer detected reception of a duplicate 
fragment.  The previous response will be resent.

Extended

DNP Error getting object header 
(Source Address, Destination 
Address, Object Type, Variation)

An error was detected in the object header of the DNP 
message.

Extended

DNP Error in get map timer (Map 
Number, N/A, N/A, N/A)

An error was detected when attempting to initialize a map-
change timer.  The operation will be retried.

Extended

DNP Error in object parse (Object 
Type, Source Address, Destination 
Address, )

The header or data portion of an object that was returned in 
a response message was invalid or otherwise unexpected.  
If possible other objects within the response will still be 
processed.

Extended

DNP Error in route change timer An error was detected when attempting to initialize a route 
table-change timer.  The operation will be retried.

Extended

DNP Error putting object header 
(Source Address, Destination 
Address, Object Type, Variation)

An error was detected in the object header during assembly of 
a response message.  The response process was aborted.

Extended

DNP Event buffer overflow (Point 
Type, N/A, N/A, N/A)

An overflow condition has been reached for the event buffer 
of the reported point type.  The oldest event will be removed 
to make room for this new event, and the overflow IIN bit will 
be set.

Extended

DNP FIR/FIN not set (Source Address, 
Destination Address, Application 
Control, N/A)

The application layer found that the FIR and FIN bits of the 
Application Control byte were not set.  The fragment was 
discarded.

Extended

DNP Fragment data size error (Source 
Address, Data Length, Data Index, 
Code Location)

The amount of data available in the fragment was not 
consistent with the expected amount of data.  The fragment 
was discarded.

Extended

DNP Fragment not found (Transport 
Header, N/A, Source Address, 
N/A)

A matching fragment was not found in the buffers for a newly 
received frame of a multi-frame fragment.  The frame was 
discarded.

Extended

DNP Fragment timed out on transmit 
list (Source Address, Destination 
Address, Application Control, 
Function Code)

The fragment was removed from the application layer transmit 
list after an extended period of inactivity.  This will normally 
only occur if the transport function and data link layer are 
unable to service transmit requests.

Extended
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Category      Event Description      Definition Log Level

DNP Frame addition failure (Transport 
Header of Fragment, Transport 
Header of Frame, Source Address, 
N/A)

A newly received frame of a multi-frame fragment was 
unable to be added to the fragment due to the 2k fragment size 
restriction.  The fragment was discarded.

Extended

DNP Function code not implemented 
(Source Address, Destination 
Address, Function Code, N/A)

The application layer received a message containing a DNP 
function code that is invalid or is not implemented.  

Extended

DNP Initial unsolicited confirmed 
(Callback Status, N/A, N/A, N/A)

Indicates that a confirmation message was received for the 
unsolicited null messages that must be sent on power up.

Extended

DNP Input point code not mapped 
(Point Type 1=binary in 2=analog 
in 3=counter, Point Code, N/A, 
N/A)

The application attempted to supply input data for a point that 
was not included in the configured point mapping.

Extended

DNP Map change callback buffer full A special function to be used to inform the application about 
map changes was unable to be added to the list.  The list was 
full.

Extended

DNP Map change callback registered A special function to be used to inform the application about 
map changes was successfully added to the list.

Extended

DNP Mesg taken off xmit list, no peer 
(Source Address, Destination 
Address, Application Control, 
Function Code)

The destination peer device was not found in the peer list, 
possibly due to a change in configuration.  The message was 
discarded.

Extended

DNP Message timed out on receive list 
(Transport Header, N/A, Source 
Address, N/A)

A fragment was removed from the transport function receive 
buffer after an extended period of inactivity.

Extended

DNP Message timed out on transmit list 
(Transport Header, N/A, Source 
Address, N/A)

A fragment was removed from the transport function transmit 
buffer after an extended period of inactivity.

Extended

DNP No peer rec found during xmit 
(Code Location, N/A, N/A, N/A)

A transmit was attempted to a device that was not found on the 
peer device list.  The transmit was aborted.

Extended

DNP No URBE delay timer No free timer was found when attempting to start an internal 
timer.

Extended

DNP Object qualifier error (Object 
Type, Source Address, Destination 
Address, Qualifier/ Index)

The qualifier code of the object that was returned in the 
response message is invalid or unsupported.

Extended
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Category      Event Description      Definition Log Level

DNP Object variation error (Object 
Type, Source Address, Destination 
Address, Variation)

The variation of the object that was returned in the response 
message is invalid or unsupported.

Extended

DNP Object/variation not supported 
(Source Address, Object Type, 
Variation, Code Location)

The object being processed does not include a support object 
and variation combination.  An attempt will be made to 
continue parsing other objects within the message.

Extended

DNP Parsed data buffer full (Object 
Type, Source Address, Destination 
Address, Variation)

The data buffer containing the parsed object data is full.  No 
further parsing of this response message will take place.

Extended

DNP Peer device added to list (Peer 
RTU Address, Port Code, Master 
Flag, N/A)

The peer device was successfully added to the peer device list. Extended

DNP Peer device already on list (Peer 
RTU Address, N/A, N/A, N/A)

Addition of the peer device to the list was unsuccessful 
because the device is already on the list.

Extended

DNP Peer device buffer full A peer device was unable to be added to the peer device list 
due to the buffer being full.

Extended

DNP Peer device not on list (Peer RTU 
Address, N/A, N/A, N/A)

The requested peer device was not found on the peer device list 
when attempting to remove the device from the list.

Extended

DNP Peer device removed from 
list (Peer RTU Address, Code 
Location, N/A, N/A)

The peer device was successfully removed from the peer 
device list.

Extended

DNP Point definition invalid (Map 
Number, Point Index, Error Data, 
Code Location)

A problem was found in the configuration data of a mapped 
point.  The map will not be initialized until the error is 
corrected.

Extended

DNP Port code invalid (Peer RTU 
Address, Port Code, N/A, N/A)

An invalid port code was detected when attempting to add a 
peer device to the peer device list.

Extended

DNP Problem with Output Block 
(Object Type, DNP Output Block 
Status Code, Point Number, 
Function Code)

An operation request was unsuccessful due to a problem in 
the Control Relay Output Block of the message.  See DNP 
documentation for a complete list of DNP Output Block status 
codes.

Extended

DNP Receive data buffer full The transport function receive data buffers are full.  These 
buffers hold the data portion of the received DNP frames.  The 
new frame is discarded.

Extended
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Category      Event Description      Definition Log Level

DNP Receive message buffer full The transport function receive message buffers are full.  These 
buffers hold the frame header information and other message 
details.  The new frame is discarded.

Extended

DNP Removed deferred read request A DNP read request that was deferred due to an outstanding 
unsolicited message was removed due to reception of a newer 
request.

Extended

DNP Reset peer link received (Source 
Address, Action Taken 1=record 
reinit 2=reset seq num only 3=new 
peer added, N/A, N/A)

A Reset data link frame was received from the reported peer 
device.

Extended

DNP Reset peer link sent (Source 
Address, Destination Address, 
N/A, N/A)

A Reset data link frame was sent to a peer device in an attempt 
to reinitialize peer-to-peer communications.

Extended

DNP Route could not be added (Route 
RTU Address, Route Table Index, 
N/A, N/A)

The routing table did not have room for the new route.  The 
route table will not be initialized.

Extended

DNP Route entry invalid (Route RTU 
Address, Route Table Index, 
Problem 1=address 2=port/IP, 
N/A)

A problem was found with one of the configured route entries.  
The route table will not be initialized until the problem is 
corrected.

Extended

DNP SBO select timer unavailable 
(Object Type, N/A, N/A, N/A)

An internal timer was not available to perform the select-
before-operate timing function.  The operation request was 
aborted.

Extended

DNP SCADA disabled URBE (Source 
Address, URBE Status, N/A, N/A)

Unsolicited Report by Exception processing was disabled over 
SCADA.

Extended

DNP SCADA enabled URBE (Source 
Address, URBE Status, N/A, N/A)

Unsolicited Report by Exception processing was enabled over 
SCADA.

Extended

DNP Sequence number mismatch 
(Source Address, Destination 
Address, Application Control, 
N/A)

The application layer found that the sequence number in the 
Application Control byte was inconsistent with what was 
expected.  The fragment was discarded.

Extended

DNP Set SBO select timer error (Object 
Type, Timer Value, N/A, N/A)

An error was detected when attempting to initialize a select-
before-operate timer.  The operation request was aborted.

Extended

DNP Set URBE timer error An error was detected when attempting to start an internal 
timer.

Extended
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Category      Event Description      Definition Log Level

DNP Special function already on list An attempt by the application to register a special memory 
read/write function was rejected because a special function for 
that memory location already exists in the buffer.

Extended

DNP Special function buffer full An attempt by the application to register a special memory 
read/write function was rejected because the buffer was full.

Extended

DNP Special function registered 
(Action 1=read 2=write, Memory 
Address, N/A, N/A)

A special function related to a specific memory action and 
virtual memory address was successfully added to the list.

Extended

DNP Transient peer add failed (Source 
Address, Application Control, 
N/A, N/A)

The source of this fragment was unknown so an attempt 
was made to add it to the peer device list.  The attempt was 
unsuccessful so the fragment was discarded.

Extended

DNP Transmit fragment buffer full No free buffer was found in the transport function transmit 
buffers.  The application layer may save this message and 
reattempt to transmit.

Extended

DNP Transmit fragment buffer full 
(Code Location, N/A, N/A, N/A)

No free buffer was found in the application layer transmit list.  
The fragment may be retried or discarded.

Extended

DNP Unknown master access restricted 
(Source Address, Destination 
Address, Function Code, N/A)

A device that was previously unknown has requested an action 
that is restricted to configured master stations.  The restricted 
actions are writes, select/operate and cold restart.

Extended

DNP URBE registration buffer full The buffer containing callback functions for unsolicited 
messages was full when attempting to add another function.

Extended

DNP Utility timer unavailable An internal timer was not available to perform the routing table 
configuration change timing function.  DNP initialization will 
be aborted.

Extended

DNP Utility timer unavailable (Map 
Number, N/A, N/A, N/A)

An internal timer was not available to perform the map-change 
timing function.  DNP initialization will be aborted.

Extended

DNP VM read or write error (Source 
Address, Memory Address, Result 
Code, Action 1=read 2=write)

A request to read or write virtual memory addresses was 
unsuccessful.

Extended

DNP AL accepted good fragment 
(Source Address, Data Length, 
Application Control, Function 
Code)

The application layer successfully accepted a complete 
fragment from the transport function.

All
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Category      Event Description      Definition Log Level

DNP App layer accepted FIN-only 
message (Transport Header, 
Fragment Length, Source Address, 
N/A)

A multi-frame fragment was successfully processed by the 
application layer and is being removed from the transport 
function buffers.

All

DNP App layer accepted FIR-FIN 
message (Transport Header, 
Fragment Length, Source Address, 
N/A)

A single-frame fragment was successfully processed by the 
application layer and is being removed from the transport 
function buffers.

All

DNP Change to point map detected 
(Map Number 0=binary in 
1=analog in 2=counter 3=control 
4=analog out, N/A, N/A, N/A)

A configuration change to a point map was detected.  This 
change will be processed 30 seconds after the last change is 
detected.

All

DNP Frame accepted by DL (Source 
Address, Destination Address, 
Transport Header, Frame Length)

A single frame was successfully handed off to the data link 
layer for transmit.  Note that this may be a single frame of a 
multi-frame fragment.

All

DNP Removed old FIR-only message 
(Transport Header, N/A, Source 
Address, N/A)

An incomplete fragment was discarded due to a newer message 
being received from the same source device.

All

DNP Route config change detected A configuration change to the routing table was detected.  This 
change will be processed 30 seconds after the last change is 
detected

All

IntelliTEAM All teams are transfer ready All teams are fully operational, and may close switches as 
necessary to transfer load and reconfigure the circuit.

Normal

IntelliTEAM Bad received mesg type (Team, 
Type)

An IntelliTEAM message was received over communications 
but contains a message type that is not recognized. The team 
the message was intended for, and the message type received, 
are included in the data.

Normal

IntelliTEAM Bad Volt Reopen Flag (team, 
value)

Associated with the “Team Member Requalify Time” feature. 
Value of 1 means that the team member is disqualified on an 
unsuccessful attempt to close and a timer is started. Value of 0 
means that the timer has cleared, and the team member can be 
considered as an alternate source again.

Normal

IntelliTEAM Close switch fail (Team, Sw) The switch/position indicated failed to close or remain closed 
after a request by the specified team. Automatic operation may 
have been disabled at this team member, or the switch may 
have reopened during the shots-to-lockout time period.

Normal

IntelliTEAM Close switch ok (Team, Sw) The switch/position indicated was successfully closed by the 
specified team.

Normal
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Category      Event Description      Definition Log Level

IntelliTEAM Config. Update, operation 
resumed

The team configuration of any of the active local teams has 
been re-enabled on the SETUP: Team screen. Team operation 
is resumed.

Normal

IntelliTEAM Config. Update, operation 
suspended

The team configuration of any of the active local teams is 
being changed on the SETUP: Team screen. While this change 
is in progress, team operation is suspended.

Normal

IntelliTEAM Contract approved switch close 
(Team)

The specified team requested a contract, which then traveled to 
the granting agent, was approved, and came back. The switch 
has closed to energize the line segment.

Normal

IntelliTEAM Contract declined (Team) The contract request made by the specified team was declined. Normal

IntelliTEAM Contract request was accepted 
(Agent)

The granting agent accepted the contract. The number for 
the specified agent is associated with the RTU address at the 
originating team member. 

Normal

IntelliTEAM Contract request was declined 
(Agent)

The granting agent declined the contract request. The number 
for the specified agent is associated with the RTU address 
at the originating team member. Note that this message can 
appear at any agent with the contract on its list.

Normal

IntelliTEAM Contract requested by member 
(Team)

The local team member has requested that the contract agent 
negotiate a contract on behalf of the specified team. 

Normal

IntelliTEAM Contract resource limitation 
(Code)

A contract agent found that resources were not available for 
load transfer, because of either segment limitations (Code 2) 
or capacity limitations (Code 3). The contract agent did not 
forward the contract any further.

Normal

IntelliTEAM Control feature fail (Team, Point) Indicates the requested control feature did not execute 
normally.

Normal

IntelliTEAM DNP rejected message (Rtu, 
Code)

An IntelliTEAM communication message to the provided 
RTU was rejected by communications. The rejection code is 
provided.

Normal

IntelliTEAM Error clrd - getting all switch data The error collecting data related to the internal switch function 
was cleared.

Normal

IntelliTEAM Error get comm task from list An error was detected when removing a message from the 
DNP communications buffer.

Normal
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Category      Event Description      Definition Log Level

IntelliTEAM Error get local switch data (Team) An error was detected when the IntelliTEAM II software 
retrieved data for the local switch in the specified team. This 
may occur if the switch/position number configured on the 
SETUP: Team screen is incorrect.

Normal

IntelliTEAM Error getting all switch data An error was detected when the IntelliTEAM II software 
collected data related to the internal switch function.

Normal

IntelliTEAM Error put coach task list (Team) The list of pending tasks that the coach carries between team 
members is full in the specified team. No more tasks can be 
put on this list until one or more of the existing tasks have been 
completed.

Normal

IntelliTEAM Error put comm task on list The coach or the team member needs to send a new message to 
another team member and the DNP communications buffer is 
full. Existing transactions must be completed before more are 
put on the communications list.

Normal

IntelliTEAM Error put event task list (Team) The list of pending team-related tasks is full in the specified 
team. No more tasks can be put on this list until one or more of 
the existing tasks have been completed.

Normal

IntelliTEAM Error put member task list (Team) The list of pending member-process tasks is full in the 
specified team. No more tasks can be put on this list until one 
or more of the existing tasks have been completed.

Normal

IntelliTEAM Event register ok (Team, Task) The task indicated has enabled event registering for the 
specified team. The registering of an event is the process of 
making all team members aware that an event has occurred.

Normal

IntelliTEAM Find alt src result (Team,  Rec) During a transfer event, the team must find an alternate source, 
based on the alternate source sequence and the normal function 
of the switches within the team (both entered on the SETUP: 
Team screen). This message indicates the resulting switch 
record, to be used for the team indicated.

Normal

IntelliTEAM Internal test point A general internal message to display data that may be 
helpful during diagnostics. Please contact S&C if you see this 
message.

Normal

IntelliTEAM Line segment faulted (Team) The line segment protected by the specified team is the 
location of the overcurrent fault on the circuit. The team will 
not attempt to restore service to this line segment.

Normal
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IntelliTEAM Manual Op. Team Condition On 
(Team)

A team entered a non-operational state because an unexpected 
manual switch operation occurred. Typically the only 
“expected” manual switch operation is closing a source 
switch on a previously faulted team which proves that the 
fault is gone, and allows RTN process to take place (if RTN is 
enabled).

Normal

IntelliTEAM Manual Op. Team Condition OFF 
(Team)

The unexpected manual switch operation team condition was 
cleared. This can only occur as a result of a user request.

Normal

IntelliTEAM Man. Op. Condition Clear Fail 
(Team)

Manual Operation condition could not be cleared on a user 
request because the local team member is not in its normal 
state.

Normal

IntelliTEAM Message timeout (Team, Code) A message on the comm list for the specified team has 
timed out, based on a timer in either the IntelliTEAM II 
software (Code 1) or in DNP (Code 2).

Normal

IntelliTEAM New coach generated (Team) A new coach has been generated at the local team member for 
the specified team. This could be caused by a power up state, 
by the existing coach being lost due to communications failure, 
or by the existing coach data being inconsistent.

Normal

IntelliTEAM Normally open sw. auto open 
(Team, Rec)

A normally open team member has opened for an automatic 
(IntelliTEAM-initiated) reason. This may happen during 
Return To Normal process. The team and the member record 
number are provided.

Normal

IntelliTEAM Not all configured teams xfer 
ready

At least one of the active teams where the local control is a 
member is not fully operational.

Normal

IntelliTEAM Prohibit restoration timer expired The timer for the Prohibit Restoration feature has expired and 
will cause Prohibit Restoration to become active. (Team 1) 
indicates the team number to which this event applies.

Normal

IntelliTEAM Rebuilding coach (Team, Code) The coach for the specified team is being regenerated. This 
may be caused by a power up event, a configuration change 
in the team, or a lost coach due to communications failure. A 
diagnostic code is also shown, contact S&C for code details.

Normal

IntelliTEAM Register event disabled (Team) The registering of events for distribution within the specified 
team has been disabled at the local team member. This was 
probably caused by a change in the team’s configuration on the 
SETUP: Team screen.

Normal
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IntelliTEAM RTN continue ok (Team, Code) The internal Return to Normal process for the specified team 
indicated that Return to Normal may continue to the next step. 
The process’s result code is also shown.

Normal

IntelliTEAM RTN disabled at switch (Team ) The Return to Normal process will not be carried out on the 
specified team because Return to Normal is disabled on the 
SETUP: Team screen.

Normal

IntelliTEAM RTN in progress on any team A team is presently returning the circuit to its normal 
configuration.

Normal

IntelliTEAM RTN not active on any team No teams are presently returning the circuit to its normal 
configuration.

Normal

IntelliTEAM RTN return failed (Team, Code) The internal Return to Normal process for the specified team 
indicated that Return to Normal cannot continue. This may be 
caused by a team member that has Return to Normal disabled 
(Code 7), or by the adjacent source team not yet being in its 
normal state (Code 6).  

Normal

IntelliTEAM RTN start event received (Team) The local team member of the specified team received a 
request to start the Return to Normal process. This follows the 
end of the Return to Normal timer and the subsequent event 
request.

Normal

IntelliTEAM RTN start event request (Team) The Return to Normal timer has expired, allowing the RTN 
process to start on the specified team. This message indicates 
that the specified team generated the event.

Normal

IntelliTEAM RTN timer started (Team) The Return to Normal timer was started by the local team 
member of the specified team.

Normal

IntelliTEAM SCADA prohibit restoration active A SCADA command was received to prevent the restoration 
of any load by this team member (the switch may not 
close automatically), however protection is not affected. If 
applicable, this message will also be displayed on power up.

Normal

IntelliTEAM SCADA prohibit restoration 
cleared

A SCADA command was received to re-enable the restoration 
of load by this team member, and the switch may be closed 
automatically. If applicable, this message will also be 
displayed on power up.

Normal

IntelliTEAM Sequence num resync (Team) The sequence numbers of events for the specified team 
have fallen out of synchronization. The last sequence 
number received is shown. The local team member will now 
resynchronize the number.

Normal
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IntelliTEAM Software mismatch on arriving 
coach

There is a software revision incompatibility within the team. 
The data fields show revision and version information for the 
team member from which the coach just arrived.

Normal

IntelliTEAM Sw opened for xfer (Team, Rec) During a transfer event, the coach of the specified team opened 
the switch indicated to allow the transfer operation to continue. 
This may occur when one or more switches within the team are 
not coordinated to open at the same time as the other switches.

Normal

IntelliTEAM Switch is xfer ready The local switch on the specified team is ready for transfer 
operations.

Normal

IntelliTEAM Switch not xfr ready The local switch on the specified team is not ready for transfer 
operations. This may be caused by an internal switch error (for 
example, a bad battery).

Normal

IntelliTEAM Switch open fail (Team, Sw) The specified team was unable to open the switch/position 
indicated.

Normal

IntelliTEAM Switch open ok (Team, Sw) The specified team successfully opened the switch/position 
indicated.

Normal

IntelliTEAM Switch open to break extended 
parallel

During a closed transition Return to Normal, the team 
member at a tie switch automatically opened the switch after a 
prescribed timeout. This insured that a circuit parallel was not 
left in place indefinitely. This condition is not normal, and may 
have resulted in load being dropped.

Normal

IntelliTEAM Team Comm Error (Team, RTU) A team-related message could not be delivered. Normal

IntelliTEAM Timer prohibit restoration active The Prohibit Restoration Timer expired, preventing the 
restoration of load by the team for which the timer expired, 
however automatic sectionalizing is not affected. If applicable, 
this message will also be displayed on power-up.

Normal

IntelliTEAM Timer prohibit restoration cleared A SCADA command was received to re-enable the restoration 
of load by this team member, and the switch may be closed 
automatically. If applicable, this message will also be 
displayed on power up.

Normal

IntelliTEAM Transfer approved (Team, Code) The transfer operation requested by the specified team, 
using the alternate source switch previously determined, was 
approved by the adjacent teams. The approval code is also 
shown. For details on the code, contact S&C.

Normal
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IntelliTEAM Transfer declined (Team, Code) The transfer operation requested by the specified team has 
been declined by the adjacent teams. The requesting team 
must look for another alternate source, or retry the operation 
on this alternate source if no other exists. Possible codes are: 
(code- definition) 2- Fault isolated, 3- Excessive load, 4- Open 
team not prepared for the transfer, 5- Closed team not prepared 
for the transfer, 6- Line segment limit exceeded, 7- Problem 
detected on one of the teams, 8- Phase loss isolated, 9- Source 
breaker isolated

Normal

IntelliTEAM Transfer in progress on any team A team is in the process of reconfiguring the circuit and 
transferring load to an alternate source.

Normal

IntelliTEAM Transfer not active on any team No teams are presently reconfiguring the circuit or transferring 
load

Normal

IntelliTEAM Unknown event/task request 
(Team)

An event or task for which the local team member is not 
programmed was requested within the specified team.

Normal

IntelliTEAM Wait for team open (team) IntelliTEAM is waiting for all switches in the team to open 
so that it can attempt to restore service to the team. This is 
likely to occur only during a 2nd contingency event.

Normal

IntelliTEAM Adjust line segment count (Team) The UIM has increased or decreased the line segment count 
associated with the Line Segment Limit setpoint following a 
transfer event.

Extended

IntelliTEAM Alt source flag cleared (Team) The line segment associated with the specified team is no 
longer being fed from an alternate source. This message 
usually follows a Return to Normal operation.

Extended

IntelliTEAM Coach collect data (Team, Goto 
Rec)

This message logs the collection of new data by the coach in 
the specified team. This data collection process occurs during 
the start of a transfer event. The team record where the coach is 
going is also shown.

Extended

IntelliTEAM Coach old, dup or CRC bad 
(Team, Code [1=old, 2=dup, 
3=CRC bad])

The coach received by the specified team is not the current 
coach – it is a duplicate of the current coach or it contains data 
inconsistent with the presently expected data. The coach is 
rejected.

Extended

IntelliTEAM Contract dissolved by member 
(Team)

The local team member has started the process to dissolve an 
active contract on behalf of the specified team.

Extended

IntelliTEAM Contract failed list add (Agent) A contract agent tried to add a new contract to its list but could 
not, so the contract was declined. The number for the specified 
agent is associated with the RTU address at the originating 
team member.

Extended
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IntelliTEAM Contract general error (Agent) The specified contract agent detected a contract error. The 
number for the agent is associated with the RTU address at the 
team member.

Extended

IntelliTEAM Contract is being dissolved 
(Agent)

An active contract is no longer needed and is in the process 
of being dissolved. The number for the specified agent is 
associated with the RTU address at the originating team 
member.

Extended

IntelliTEAM Contract pending fail (Team, 
Team)

The requesting contract agent was waiting for a response when 
the timer ran out, so it failed the contract. The coach may 
restart the contract request if it cannot find another alternate 
source. This message shows the two teams involved with the 
transfer process at this team member location, where (Team 1) 
is the requesting team.

Extended

IntelliTEAM Contract reactivated (Agent) The contract is missing somewhere along its routing path, so 
the requesting agent reactivated the contract. The number for 
the specified agent is associated with the RTU address at the 
originating team member.

Extended

IntelliTEAM Contract receiver busy (Agent, 
Agent)

A contract agent’s receiver buffer was full, so a contract 
message was dropped. The numbers for the specified agent 
are associated with the RTU address at the originating team 
member.

Extended

IntelliTEAM Control feature ok (Team, Point) Indicates the requested control feature executed normally. 
Possible point values are: 1 Point to operate switch,  2 Point 
to block reclosing,  3 Point to block ground trip,  4 Point to 
change profile.

Extended

IntelliTEAM Loading data reset (Team, Code) When a transfer with a known load value occurs, the 
IntelliTEAM II software resets the loading data to reflect the 
new value. This updates the information more quickly than the 
“2-minute” load averaging. The code relates to the state of the 
reset process.     

Extended

IntelliTEAM Op sw func return (Team, Code) This message displays the internal code returned during the 
operation of the local switch in the specified team. Contact 
S&C for code details, this code is application specific.

Extended

IntelliTEAM RTN process stopped (Team, 
Code)

The Return to Normal process completed at the local team 
member with the indicated completion code. For details on the 
code, contact S&C.

Extended

IntelliTEAM Unexpected State Change (Team) The transfer state went through an unexpected transition at 
the specified team. This error might stop an ongoing transfer 
process.

Extended
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IntelliTEAM Volt/fault reset occurred (Sw) The voltage loss and overcurrent indications maintained by 
the IntelliTEAM II software have been reset after either the 
Sectionalizer Reset Time or, if a transfer event has occurred, 
after team reconfiguration is complete.

Extended

IntelliTEAM Action path complete (Team) This message is displayed when the action path for operating 
the switch gear has completed all possible steps in either the 
forward or reverse direction.

All

IntelliTEAM Coach arrived (Team) This message logs the arrival of the coach, along with all the 
updated data, at the local team member for the specified team.

All

IntelliTEAM Coach arrived on request (Team) This message logs the arrival of the coach at the local team 
member of the specified team after the local team member 
requested the coach.

All

IntelliTEAM Coach hold override (Team,  Goto 
Rec )

When the team member of the specified team holds the coach 
for an extended period of time, an override occurs that allows 
the coach to briefly visit other team members. This prevents 
the coach from becoming old and regenerated by an adjacent 
team member. The team record where the coach is going is 
also shown.

All

IntelliTEAM Coach is held by member (Team) The coach for the specified team is being held by the local 
team member. This occurs when a process is taking place at the 
local team member that requires the presence of coaches from 
both adjacent teams.

All

IntelliTEAM Coach left (Team, Goto Rec) This message logs the departure of the coach from the local 
team member for the specified team, and indicates where the 
coach is going next.

All

IntelliTEAM Contract added to list (Team, 
Team)

A new contract was added to the list of contracts being 
maintained. This message shows both the requesting and 
granting teams associated with the transfer process. The 
requesting team (Team 1) identifies the origin of the contract.

All

IntelliTEAM Contract cannot travel (Agent) The requesting contract agent does not know where the 
present source is, so it could not forward the contract request. 
The contract failed. The number for the specified agent is 
associated with the RTU address at the team member.

All

IntelliTEAM Contract comm received (Team, 
Team)

The contract agent has received a message. (Team 1) refers to 
the contract’s originating segment, and (Team 2) refers to the 
temporary segment, usually the segment through which the 
message just passed.

All

Data Logging



  S&C Instruction Sheet 1043-550  57

Category      Event Description      Definition Log Level

IntelliTEAM Contract dup rcvd (Agent , State) The specified requesting agent received an old or duplicate 
contract message, which refers to the indicated contract state. 
The number for the agent is associated with the RTU address at 
the team member.

All

IntelliTEAM Contract maintained (Agent) Scheduled maintenance of a contract was performed by the 
specified requesting agent to confirm the continued need for 
the contract. The number for the agent is associated with the 
RTU address at the team member.

All

IntelliTEAM Contract not found (Agent) A contract agent received a message about a contract that is not 
in its list. This may result in the contract being dissolved and, 
if necessary, reactivated. The number for the specified agent 
is associated with the RTU address at the originating team 
member.

All

IntelliTEAM Contract request travel (Team,  
Rec)

A contract request is traveling between teams. (Team 1) is the 
segment through which the request just came, and (Rec 2) is 
the team member in the direction where the request is headed.

All

IntelliTEAM Contract requires member wait 
(Team )

The specified team is waiting for a contract to be requested, 
granted, or declined.

All

IntelliTEAM Contract started by member 
(Team)

A member of the specified team has determined that it can 
close based on information from the coach, but it must first 
request a contract.

All

IntelliTEAM Contract transmit busy (Agent) A contract agent’s transmit buffer was full. The message is 
held until the transmit buffer has space, and is then sent. The 
number for the specified agent is associated with the RTU 
address at the originating team member.

All

IntelliTEAM DNP feeder loading data rcvd 
(Data)

Feeder loading data has been received from the source 
substation or breaker, and may be used in determining the 
capacity of the circuit during transfer operations. Data 1 
indicates the circuit loading received in increments of 10 amps 
per count.

All

IntelliTEAM Member cleared task lock 
attributes

The team member logic cleared the execution lock on tasks 
present on the task list. These tasks may now be executed by 
the team member.

All

IntelliTEAM Member requested (Team,  Task) The specified team has requested that the local team member 
execute the task indicated.

All
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IntelliTEAM Monitor line segment (Team) The specified team has an indication to start a transfer event, 
but the line segment is still energized. The team monitors the 
segment until it is deenergized.

All

IntelliTEAM Next action (Action,  Direction) The operation of the switch gear is progressing to the next 
action within the action path. (Action 1) indicates the action 
to be taken and can be one of the following codes:  3 Close 
for xfer, 20 Contract request, 21 Contract Terminate, 30 
Block recloser, 31 Unblock recloser, 33 Block ground trip, 34 
Unblock ground trip, 36 Alternate settings, 37 Normal, 253 
Action path done.  (Direction 2) is the direction the action path 
is going, either Forward (1) or Reverse (2).

All

IntelliTEAM Not rdy, discard task (Team, Task) The indicated task has been discarded because the specified 
team was not ready to transfer. This is typically the result of a 
local or team error condition.

All

IntelliTEAM Old or dup task discarded (Team) The task taken from the event list on the specified team is 
either old or is a duplicate of an existing task. This occurs 
normally in the operation of the team as events are distributed 
throughout the team.

All

IntelliTEAM Pending comm message cleared 
(Team)

The coach has determined that a pending message is no longer 
valid, and should be removed from the communications 
transmit list.

All

IntelliTEAM Task travel (from Team, Team) During a Return to Normal process, tasks associated with 
the process travel among multiple teams between the normal 
source and the normal tie point of the circuit. This message 
traces the path of the tasks.

All

IntelliTEAM Volt/fault idle xfer state (Sw) This message is output when all teams that the UIM is a 
member of have their transfer stated back to idle, signaling a 
reset of the total 3 phase average load.

All

IntelliTEAM Volt/fault OC cleared (Team,  Rec) This message is output when an overcurrent fault was 
previously detected, the field now is not faulted and 3 phase 
voltage has returned, causing the coach to clear the latched 
overcurrent condition. For details on (Rec 2) contact S&C.

All

IntelliTEAM Volt/fault PL cleared (Team, Rec) This message is output when a phase loss was previously 
detected, the external device is now in its normal open or close 
state, real time 3 phase voltage is present, causing the coach to 
clear the latched phase loss condition. For details on (Rec 2) 
contact S&C.

All
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IntelliTEAM Volt/fault VL cleared (Team, Rec) The coach clears a 3 phase voltage loss when: 3 phase voltage 
loss was previously detected and real time 3 phase voltage is 
now present and either the external device is in its normal state 
or the external device’s normal job is a source sub. For details 
on Rec 2, contact S&C.

All

IntelliTEAM Xfer State Change (Team) The transfer state changed for the specified team. All

LOG Compact flash card not found Compact Flash logging Setpoint is on but either no CF card is 
inserted or the card is not formatted correctly. The only way to 
fix this is to insert a working CF card.

Normal

LOG Compact flash card swap detected The application determined that the compact flash card has 
been swapped.

Normal

LOG Compact flash data likely lost on 
err

A Compact Flash operation was interrupted before completion. 
The file on which this occurred was saved with a .ERR 
extension and abandoned. Some events may have been lost 
from the CF log. The primary reason for this condition is a 
loss of power while CF card is active - a highly improbable but 
possible event. Another reason is that the card was pulled out 
while data was being written to it. This is why it is necessary 
to disable CF logging either through the IntelliLINK screen, or 
the faceplate keypad before removing the card. Notify S&C if 
you see this message more than a few times.

Normal

LOG CF buffer processed early to 
preserve data

The application tries to access the CF every several seconds 
at a fixed time interval to increase overall application 
performance. However, if the volume of event data is such that 
the interval is not soon enough, logging events are saved to the 
CF card more frequently, which is what this message means. 
This message does not indicate any loss of event data and is to 
be expected during heavy team activity.

All

LOG Compact flash operation failed A CF disk error occurred while saving logs to the CF card. 
There may be many reasons for this, but errors seldom occur. 
If this message occurs persistently, replace the CF card to 
ensure continued logging, and notify S&C.

All

LOG DNP error Logging could not communicate to DNP. All

LOG Logging overflow (Last Events) A large but not infinite number of events can be logged per 
unit of time. This message is displayed when this limit is 
reached or exceeded. The internal identification of last events 
is supplied in the data columns, and is diagnostic information 
for S&C. Data is seldom lost, but this message may indicate 
data loss. If you see this message often, please contact S&C.

All
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UIM Any phase overcurrent cleared The external device reports that an overcurrent condition has 
been cleared on one or more phases.

All

UIM Any phase voltage loss cleared The external device reports that a voltage loss condition has 
been cleared on one or more phases.

All

UIM Automatic operation enabled The external device reports that automatic operation is enabled. All

UIM Communication lost to E.D. 
cleared

When the external device (E.D.) starts communicating again, 
this message is output.

All

UIM Communication to E.D. lost When the external device (E.D.) stops communicating, for 
example a radio problem, this message is output.

All

UIM Communication to E.D. running When BEGIN SETUP is set to Running this message is output. All

UIM Communication to E.D. stopped When BEGIN SETUP is set to Stopped this message is output. All

UIM Control device voltage loss 
cleared

The UIM has detected the external device report that voltage 
has returned to the source side.

All

UIM Control point operation req. The UIM is issuing a control request on behalf of IntelliTEAM 
II to the external device. Data 1 indicates the control point 
being operated. The codes have the following meaning:

  1 = Close

  2 = Trip (Open)

60 = Normal Profile (settings group 1)

61 = Alternate Profile 1 (settings group 2)

62 = Alternate Profile 2 (settings group 3)

63 = Alternate Profile 3 (settings group 4)

58 = Alternate Profile 4 (settings group 5)

59 = Alternate Profile 5 (settings group 6)

64 = Reclosing Block

65 = Ground Trip Block

66 = Hot Line Tag

All

UIM Control profile enabled If the normal profile is supported and the reported status does 
match, any previous mismatch errors are cleared and this 
message is output.

All
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UIM Ctrl operation retries failed This message is only sent for IntelliTEAM initiated control 
point requests. The timeout is configured at: External Device 
Menu, Control Points, Control Point Operation Timeout (secs). 
The default timeout is 10 seconds. After half of the timeout 
(normally 5 seconds) one retry is initiated. If the status hasn’t 
changed after the timer has elapsed (normally 10 seconds), this 
message is output.

All

UIM Ctrl point operation retry This message is only sent for IntelliTEAM initiated control 
point requests. The timeout is configured at: External Device 
Menu, Control Points, Control Point Operation Timeout (secs). 
The default timeout is 10 seconds. After half of the timeout 
(normally 5 seconds) one retry is initiated.

All

UIM Ctrl point operation successful The UIM has verified the successful completion of the control 
request initiated by IntelliTEAM II.

All

UIM Data poll sent to host device The DNP request for binary status, analog inputs, and binary 
counters is being sent to the external/host device at the 
External Device Menu - Module-to-Control Dev. Polling 
Interval.

All

UIM Data received from host device The DNP data poll requested by the UIM to the external device 
has been received.

All

UIM Device data updates disabled The Device Data Updates parameter on the BEGIN SETUP 
screen has been set to Stopped, preventing data retrieved 
from the external device from being used by SCADA and 
IntelliTEAM II.

All

UIM Device data updates enabled The Device Data Updates parameter on the BEGIN SETUP 
screen has been set to Running, allowing data retrieved from 
the external device to be used by SCADA and IntelliTEAM II.

All

UIM DNP appl. layer timeout The application layer of DNP communications within the UIM 
did not receive a confirmation for the latest request issued 
within the message confirmation time limit. The timeout is 
configured at: External Device Menu, module to control dev 
polling timeout.

All

UIM E.D. trouble active When trouble status points are programmed at the UIM, when 
they become active, this message is output.

All

UIM E.D. trouble cleared When trouble status points are programmed at the UIM, and 
the trouble clears, this message is output.

All
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UIM Ext VLoss/PLoss qual-Sw already 
open

When extended phase or three phase voltage losses are 
qualified and the reported switch status is open, this message 
is output.

All

UIM Fault cycling state cleared The UIM has detected that the external device fault cycling 
status has cleared.

All

UIM Frequency trip active The UIM has detected that the external device had tripped open 
due to a frequency anomaly.

All

UIM Frequency trip cleared The UIM has detected that the external device had tripped open 
due to a frequency anomaly, and that the frequency condition 
has cleared.

All

UIM Frequency trip inactive The UIM has detected that the external device has not tripped 
open due to a frequency anomaly.

All

UIM Ground trip mismatch cleared The UIM had detected a mismatch in Ground Trip setting 
between the present state of the external device and the state 
as configured in the SETUP: Automatic Operation screen. 
The mismatch is now cleared, and the associated team is not 
prevented from being Ready.

All

UIM Ground trip mismatch detected The UIM has detected an unexpected mismatch in Ground Trip 
setting between the present state of the external device and the 
state as configured in the SETUP: Automatic Operation screen. 
Until cleared this mismatch will prevent the associated team 
from being Ready.

All

UIM Hot line tag active The UIM has detected that the Hot Line tag feature of the 
external device is active.

All

UIM Hot line tag inactive The UIM has detected that the Hot Line Tag feature of the 
external device is inactive.

All

UIM IntelliTEAM disabled extended 
PL/Vloss

When teams go out of ready, IntelliTEAM will signal the UIM 
to disable extended loss of voltage operation, if the UIM is 
programmed for this operation.

All

UIM IntelliTEAM enabled extended 
PL/Vloss

When teams are ready, IntelliTEAM will signal the UIM 
to enable extended loss of voltage operation, if the UIM is 
programmed for this operation.

All

UIM Open on extended PL or VL failed When the UIM sends the command to open on extended phase 
or 3 phase voltage losses and the switch status doesn’t change, 
this message is generated.

All
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UIM Profile mismatch error If the normal profile is supported and the reported status 
doesn’t match, a 30-second timer is started to see if 
IntelliTEAM is trying to change the profile. If the timer expires 
without a detected change, a mismatch error is sent.

All

UIM Protection settings-mapped pts 
mismatch

When protection settings are enabled in SETUP: Automatic 
Operation and associated control, analog and status points 
are not mapped in the UIM. When BEGIN SETUP is set 
to Running a check is made for the mapped points and a 
mismatch condition is entered causing a not ready team alarm. 
When the points are not correct and going to Running has 
found an error, this message is output.

All

UIM Protection settings-mapped pts 
OK

When protection settings are enabled in SETUP: Automatic 
Operation and associated control, analog and status points 
are not mapped in the UIM. When BEGIN SETUP is set 
to Running a check is made for the mapped points and a 
mismatch condition is entered causing a not ready team alarm. 
When the points are correct and going to Running finds no 
errors, this message is output.

All

UIM Recloser blocked timer expired After the UIM has verified a close operation, IntelliTEAM will 
wait an additional amount of time specified at: External Device 
Menu, SETUP: Automatic Operation, Recloser Block Time.

All

UIM Recloser/relay is fault cycling If the recloser/relay is programmed for fault cycling, this 
message is output when fault cycling is active.

All

UIM Recloser/relay is in reset state If the recloser/relay is programmed for fault cycling, this 
message is output when a reset state is entered.

All

UIM Recloser/relay not in reset state The UIM has detected that the external device status is no 
longer in reset.

All

UIM Reclosing mismatch cleared The UIM had detected an unexpected mismatch in Reclosing 
setting between the present state of the external device and 
the state as configured in the SETUP: Automatic Operation 
screen. The mismatch has been cleared and will not prevent the 
associated team from being Ready.

All

UIM Reclosing mismatch detected The UIM has detected an unexpected mismatch in Reclosing 
setting between the present state of the external device and the 
state as configured in the SETUP: Automatic Operation screen. 
Until cleared this mismatch will prevent the associated team 
from being Ready.

All
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Category      Event Description      Definition Log Level

UIM Remote mode disabled The UIM detected that the Remote Mode of the external 
device has been disabled. When Remote Mode is disabled, the 
UIM will not be able to operate the external device, whether 
requested to do so from SCADA or from IntelliTEAM II.

All

UIM Remot mode enabled The UIM detected that the Remote Mode of the external device 
has been enabled. When Remote Mode is enabled, the UIM 
may be able to operate the external device, whether requested 
to do so from SCADA or from IntelliTEAM II.

All

UIM Response timeout from H.D. The UIM did not receive a response from the external device 
within the required timeout, which is configured at: External 
Device Menu, module to control dev polling timeout.

All

UIM SCADA ctrl point operation Req. The UIM has received a control request from SCADA to be 
directed toward the external device. Data 1 displays the actual 
point number associated with the external device. Refer to 
your points list for this external device to determine the point’s 
function. Data 2 contains the operation requested on that point 
from the SCADA master.

All

UIM Single phase VLoss trip active When the UIM is programmed to do extended phase loss 
protection, this message is output.

All

UIM Single phase VLoss trip cleared On any close operation, this message is output and clears any 
previous active status.

All

UIM Switch position close detected The UIM has detected that the close state of the external device 
is reported.

All

UIM Switch position open detected The UIM has detected that the open state of the external device 
is reported.

All

UIM Three phase VLoss trip active When UIM is programmed to do extended three phase voltage 
loss protection, this message is output.

All

UIM Three phase VLoss trip cleared On any close operation, this message is output and clears any 
previous active status.

All

UIM Tripped to lockout active The UIM has detected that the external device has tripped to 
the lockout state as a result of an event. Once in the lockout 
state IntelliTEAM II may begin the reconfiguration process.

All

UIM Tripped to lockout cleared The external device has cleared a previously reported lockout 
condition.

All
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Logging Status Points

Figure 15. Logging Status Points Screen.

From any Data Logging screen click the Status Points button to display the Logging 

Status Points screen.

Status points are used to indicate whether a certain condition is active or inactive right 
now, as well as how many times it has been active. Timestamps are also supplied to indicate 
when the condition last became active and when it was last cleared.

There are exactly two historic events (also placed in the Historic Event Log) associated 
with each status point—one event for the status point becoming active and one for the 
status becoming inactive.  For example, if a status point has become active 100 times 
and is active now, there will be 199 related events in the Historic Log—100 for the status 
becoming active, and 99 for the status clearing. Therefore, Status Points screens exist 
for convenience—they do not provide any information that can not be deduced from the 
Historic Event Log that resides in memory and/or on Compact Flash.

Each logging status point can optionally be mapped in the DNP point map, see Instruction 
Sheet 1043-530, page 33. Whenever a status point thus mapped changes its status, Data 
Logging will notify the DNP communications layer of the UIM software about the change. 
In this way status point information can be made retrievable via SCADA.

Currently the application may contain up to 48 status points, displayed on three screens 
that are connected via Page Up/Page Down buttons. Here are the pieces of data associated 
with each status point, each residing in a separate column of the table on the screens: 

Status Description

Describes briefly what the status point is. The list of status points is further down. Note 
that IL needs to be connected to the control for this column to contain any descriptions.
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Status

ACTIVE means that the condition which this status point represents is active right now; 
while INACTIVE means that the condition which this point represents is not active right 
now.   

Total Cnt

How many times the status point has been active since the application was downloaded 
first. 

Current Cnt

How many times the status point has been active since status points were reset last time 
(either using the “Clear Status Counters” feature on the Logging Setup screen, or the 
identical feature in the lower right corner of this screen).

Time Active

At what time the status last became active. This is cleared together with “Current Cnt” by 
the user, when the “Clear Status Counters” feature is used.

Time Cleared

At what time the status was cleared last. This is cleared together with “Current Cnt” by 
the user, when the “Clear Status Counters” feature is used.

In addition to showing the status table, the screens allow to clear status point counters 
and timestamps and show the time of last status clearing. That functionality is available 
in the lower portion of the Logging Status Point screen and is also found on the Data 

Logging Setup screen.

Here is the list of status points currently supported by the UIM. The number in parenthe-
sis is the internal point code, that needs to be supplied in the appropriate DNP mapping 
screen to make the point accessible to SCADA.

Status Point Description Category Explanation

Err get local sw. data (519) IntelliTEAM Active when IntelliTEAM fails to receive all 
data necessary for its operation from the 
external device.

Manual Op. Team Condition 
(520)

IntelliTEAM Active if any team registered a manual 
switch operation (Open or Close) such 
that it became not fully operational. Some 
manual operations will not cause this condi-
tion, most notably closing a source switch 
on a previously faulted team to allow TRN 
(if RTN is enabled) to take place.
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Status Point Description Category Explanation

Not all teams xfer rdy (513) IntelliTEAM Active if any teams where the local control 
is a member are not fully operational. This 
may be due to error conditions at individual 
team members (see Switch not xfer rdy), 
or team wide conditions such as isolation 
of a fault, team configuration errors, team 
coordination errors, automatic restoration 
prohibited, and team logic disabled on the 
TEAM: Setup screen. If Switch not xfer rdy 
is active in one switch control of a team, 
this will cause this indication to be set in 
the other team members.

RT-Load Data Problem (522) IntelliTEAM This point is set when the DNP analog out-
put value received is less than the real-time 
3-phase total load as reported by the host 
device, and is also set if the real-time feeder 
loading data has not updated within the 
configured time interval. This point will be 
set to 0 if the real-time feeder loading logic 
is inactive.

RTN in progress (515) IntelliTEAM Active while the team is returning the cir-
cuit to its normal configuration.

SCADA Prohibit Rest. (516) IntelliTEAM Active when a SCADA command was 
received to prevent the restoration of any 
load by this team member. Will also be 
activated when Prohibit Restoration is 
requested via IntelliLINK or the Keypad.

Setup Data Revision (518) IntelliTEAM Active when the configuration data for an 
enabled team has been modified. It remains 
active until the field is disabled and then 
re-enabled. You can clear this error in two 
ways:  1. Set the Team Setup setpoint (on 
the SETUP: Team screen) to Stopped, 
then set it to Running. 2. Reload the team 
configuration data using the IntelliLINK 
software. Select File > Load Setpoints. This 
process automatically stops and restarts the 
“Team Setup” setpoint.

Src. Loading Data Active 
(521)

IntelliTEAM This point will be set when the real-time 
feeder loading logic is active and in use. 
This point does not indicate whether the 
control is using actual real-time feeder load-
ing data received from a DNP master, or 
using the Default Source Segment Loading 
setting.
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Status Point Description Category Explanation

Switch Not Xfer Rdy (512) IntelliTEAM Active when the external device operation 
is not consistent with the expected team 
operation (i.e. incomplete or manual switch 
operation or inconsistent switch position).

Team 1 in Ready (523) IntelliTEAM IntelliTEAM active when the team is in the 
Ready to Transfer state. This point will be 
inactive if the team is not in use, contains 
an error condition, or the line section repre-
sented by the team contains a fault.

Team 2 in Ready (524) IntelliTEAM IntelliTEAM active when the team is in the 
Ready to Transfer state. This point will be 
inactive if the team is not in use, contains 
an error condition, or the line section repre-
sented by the team contains a fault.

Team 3 in Ready (525) IntelliTEAM IntelliTEAM active when the team is in the 
Ready to Transfer state. This point will be 
inactive if the team is not in use, contains 
an error condition, or the line section repre-
sented by the team contains a fault.

Team 4 in Ready (526) IntelliTEAM IntelliTEAM active when the team is in the 
Ready to Transfer state. This point will be 
inactive if the team is not in use, contains 
an error condition, or the line section repre-
sented by the team contains a fault.

Team 5 in Ready (527) IntelliTEAM IntelliTEAM active when the team is in the 
Ready to Transfer state. This point will be 
inactive if the team is not in use, contains 
an error condition, or the line section repre-
sented by the team contains a fault.

Team 6 in Ready (528) IntelliTEAM IntelliTEAM active when the team is in the 
Ready to Transfer state. This point will be 
inactive if the team is not in use, contains 
an error condition, or the line section repre-
sented by the team contains a fault.

Team 7 in Ready (529) IntelliTEAM IntelliTEAM active when the team is in the 
Ready to Transfer state. This point will be 
inactive if the team is not in use, contains 
an error condition, or the line section repre-
sented by the team contains a fault.

Team 8 in Ready (530) IntelliTEAM IntelliTEAM active when the team is in the 
Ready to Transfer state. This point will be 
inactive if the team is not in use, contains 
an error condition, or the line section repre-
sented by the team contains a fault.
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Status Point Description Category Explanation

Timer Prohibit Rest. (517) IntelliTEAM Active when the Prohibit Restoration timer 
for that team runs out. The timer com-
mand only affects the team on which it has 
expired. When enabled the timer count-
down will be initiated at the same time a 
transfer process begins at a team, usually 
at the time a sectionalizing event occurs. 
Although it will often be the case that tim-
ers in adjacent teams start simultaneously, 
there is no requirement for this to occur. 
Each team will decrement its timer inde-
pendently from other teams, and potentially 
enter the Prohibit Restoration state asyn-
chronously.

WARNING:  Because teams may asyn-
chronously enter the Prohibit Restoration 
state, one or more disconnected teams 
throughout a circuit, or a system, may be 
prohibited from further automatic restora-
tion activity, while others may continue as 
necessary for subsequent events. For this 

reason it is extremely important that 

standard safety practices are adhered 

to when working on a circuit that has 

been involved in automatic transfer and 

restoration. Disabling automatic operation 
and tagging devices are strongly recom-
mended before performing any manual 
switching or repair.

Xfer in progress (514) IntelliTEAM Active while the team is in the process of 
reconfiguring the circuit and transferring 
load to an alternate source.

Any Phase LOV (336) UIM Active when status points from the external 
device report voltage losses or the analog 
input from the external device is less than 
the Auto setup voltage loss threshold.

E.D. Contacts Bad (355) UIM Active when the external device is reporting 
that the switch open and closed status are 
the same.

E.D. Comm Lost (353) UIM Active when the external device (E.D.) 
stops communicating, e.g. due to a radio 
problem.

E.D. Comm Stopped (352) UIM Active when BEGIN SETUP is set to 
“Stopped”. Cleared when BEGIN SETUP is 
set to “Running”.

E.D. Trouble (354) UIM Active when trouble status points are 
programmed at the UIM and they become 
active.
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Status Point Description Category Explanation

Frequency Trip (339) UIM Active when the Interface Module has 
detected that the host tripped open due to 
a frequency anomaly on the circuit. The 
Interface Module forces a Stop Transfer 
condition, preventing IntelliTEAM II from 
attempting to operate the relay/recloser 
device.

Ground Trip Mismatch (340) UIM Active when the Interface Module has 
detected that the state of the host’s Ground 
Trip feature is no longer in the expected 
state. The Interface Module assumes this 
change of state is due to human interven-
tion and will force a Stop Transfer con-
dition, preventing IntelliTEAM II from 
attempting to operate the relay/recloser 
device.

Hot Line Tag (337) UIM Active when the UIM has detected that the 
hot line tag feature of the external  device 
is active.

LOV Sect. Enabled (349) UIM Active when teams are ready and 
IntelliTEAM instructs the UIM to enable 
extended loss of voltage operation (if the 
UIM is programmed for this operation). Set 
to inactive when teams go out of ready and 
IntelliTEAM disables the feature.

Over Current (344) UIM Active when the external device reports 
that an overcurrent condition has been 
detected on one or more phases.

Profile Mismatch (342) UIM Active when the normal profile is sup-
ported , the reported status doesn’t match, 
and the 30 second timer started to see if 
IntelliTEAM is trying to change the profile 
has expired.

Protection Config. Error 
(343)

UIM Active when the UIM is programmed to con-
trol the profile in the external device, the 
UIM is programmed to block and unblock 
reclosing, or the UIM is programmed to 
initiate extended loss of voltage trips in the 
external device; and status points, control 
points or analog inputs have not been pro-
grammed to support these features.
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Status Point Description Category Explanation

Reclose Mismatch (341) UIM Active when the Interface Module has 
detected that the state of the host’s 
Reclosing feature is no longer in the 
expected state. The Interface Module 
assumes this change of state is due to 
human intervention and will force a Stop 
Transfer condition, preventing IntelliTEAM 
II from attempting to operate the relay/
recloser device.

Recloser Cycling (347) UIM Active when  the recloser/relay is pro-
grammed for fault cycling and fault cycling 
is active.

Recloser Cycling Reset (348) UIM Active when the recloser/relay is pro-
grammed for fault cycling and reset state is 
entered.

Remote Disabled (338) UIM Active  when the host relay/recloser device 
indicates it is not able to accept commands 
from a remote source. The remote source 
can be either SCADA or the Interface Mod-
ule itself.

Single Phase Trip (350) UIM Active when UIM is programmed to do 
extended phase loss protection and the 
switch trips for that reason. Cleared on any 
close operation.

Three Phase Trip (351) UIM Active when UIM is programmed to do 
extended three phase voltage loss pro-
tection and switch trips for that reason. 
Cleared on any close operation.

Tripped to Lockout (346) UIM Active when the UIM has detected that the 
external device has tripped to the lockout 
state as a result of an event. Once in the 
lockout state IntelliTEAM II may begin the 
reconfiguration process.
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Special Event Counters

Figure 16. Special Event Counters Screen.

From any Data Logging screen click the Special Events button to display the Special 

Event Counters screen.

The application considers some historic events “special” and keeps track of how many 
times they’ve occurred, as well as when they occurred first and when they occurred last. A 
typical example of a special event would be some event that adversely impacts operation 
of the UIM, such as a failure of Compact Flash. 

Each special event counter can optionally be mapped in the DNP point map. See Instruc-
tion Sheet 1043-530, page 33. Whenever a special event thus mapped occurs, Data Logging 
will notify the DNP communications layer of the UIM software about the occurrence. In 
this way special event counter information can be made retrievable via SCADA. 

Currently, the application can have up to 32 special events, which are contained on two 
screens, linked with Page Up/Page Down buttons. Here are the pieces of data comprising 
a Special Event Counter record, each residing in a separate column of the table on the 
Special Event Counters screens:

Event Description

Describes briefly what the special event is. The list of all special events is further down. Note 
that IL needs to be connected to the control for this column to contain any descriptions

Total Cnt

How many times the event has occurred since the application was downloaded first

Current Cnt

How many times the event has occurred since the special events were reset last time 
(either using the “Clear Special Event Counters” feature on the Logging Setup screen, or 
the identical feature in the lower right corner of this screen)
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 Last Time Active

When the special event occurred last, since the special event counters were reset

First Time Active

When the special event occurred first, since the special event counters were reset

 

In addition to showing the Special Events table, these screens allow for clearing special 
event counters and timestamps and show the time of last clearing. That functionality is 
available in the lower portion of the Special Event Counters screens and is identical to 
that on the Logging Setup screen.

Here is the list of all special events currently supported by the UIM. The number in paren-
thesis is the internal point code, that needs to be supplied in the appropriate DNP mapping 
screen to make the point accessible to SCADA.

Event Description Category Explanation

Compact Flash Failure (768) Logging This event occurs when CF disk error 
is detected while saving logs to CF 
card. There may be many reasons for 
this but the message should come up 
very rarely, if ever. If this happens 
persistently, replace the CF card to 
ensure continued logging and notify 
S&C.

Logging Overflow (769) Logging A large but not infinite number of 
events can be logged per unit of time. 
This event occurs when that limit is 
reached or exceeded. When this event 
occurs data may be lost. If you see 
this often, please contact S&C.

CF Data Likely Lost on Err (770) Logging This event occurs when a compact 
flash operation was interrupted 
before completion. The file on which 
this occurred was saved with a .ERR 
extension and abandoned. Some 
events may have been lost from CF 
log. The primary reason for this condi-
tion is a loss of power while CF card 
is active-- a highly improbable but 
possible event. Another reason is that 
the card was pulled out while data 
was being written to it-- this is why 
it is necessary to disable CF logging 
either with the IntelliLINK screen, or 
the Keypad, before removing the card. 
Notify S&C if you see this more than a 
few times.
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Event Description Category Explanation

New coach generated on 
team (512)

IntelliTEAM This event occurs when the coach 
does not arrive within a predeter-
mined timeout. This causes the team 
member to generate a new coach and 
attempt to restore team synchroniza-
tion.

Team Comm Error (513) IntelliTEAM This event occurs when any team 
related message is not successfully 
transmitted via DNP.

Unexpected state change (514) IntelliTEAM This event occurs if in the course of 
team transfer an unexpected sequence 
of steps is taken.

Rebuilding coach (515) IntelliTEAM This event occurs if the coach is lost 
during operation of the system. The 
team circulates a special coach to 
restore synchronization. This coun-
ter increments whenever the special 
coach arrives at a member.

Err. put coach task list (516) IntelliTEAM This event occurs when a list of 
pending tasks that the coach carries 
between team members is full. No 
more tasks can be put on this list until 
one or more of the existing tasks have 
been completed.

Err. put event task list (517) IntelliTEAM This event occurs when a list of 
pending team-related events is full. 
No more events can be put on this 
list until one or more of the existing 
events have been completed.

Err. put member task list (518) IntelliTEAM This event occurs when a list of pend-
ing member-process tasks is full. No 
more tasks can be put on this list until 
one or more of the existing tasks have 
been completed.

Err. put comm task on list (519) IntelliTEAM This event occurs when the coach or 
the team member needs to send a new 
message to another team member 
and the DNP communications buffer 
is full. Existing transactions must be 
completed before more are put on the 
communications list.

Seq num resync (520) IntelliTEAM This event occurs when the sequence 
numbers of events have fallen out of 
synchronization.
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System Startup History

Figure 17. System Startup History Screen.

The control keeps track of the times when the system stops running and starts running. 
The most recent system down/system up events are reflected in a table kept in the memory 
of the control. The table has eight slots and is sorted in ascending chronological order. 
There are two columns:

System Down Time

Time when power to the control was lost. Note that in the case when the system started 
up as a result of an application download this item is going to be empty.

NOTE: this time is approximate, with the precision of about half a second.

System Up Time

Time when power to the control was restored or the application was downloaded. The 
System Down Time in the same row subtracted from this value equals the amount of time 
the system was not running.
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Historic Event Log IntelliLINK Historic Event View screens can show only a small portion of all historic events 
stored in the control memory. To view the 4,096 events stored in control memory, use the 
IntelliLINK HTML log feature. To access the IntelliLINK HTML Log:

1.   Go to the Data > Event/Data logs menu in IntelliLINK to open the “Select Log 
 Dialog. Expand the item in the dialog and choose the “Historic Event Log”   
 option. 

2.   Click OK. You may check the “Save To File” checkbox to generate an HTML file  
 on your disk. 

3.   Wait several minutes while event data is downloaded from the control. 

4,   The log containing all historic events in the control memory will be displayed 
 in an Internet Explorer window (unless the “Save To File” checkbox was   
 checked). 

The resulting log is sorted chronologically and contains up to 4,096 of the newest historic 
events that have been logged.

The columns in the HTML log table are identical to those on the Historic Event View 
screens. The HTML file can be opened with Microsoft Excel, or copied and pasted into 
Excel, where it can be re-arranged in any way that the spreadsheets will allow.

Compact Flash Log Compact flash logging requires a 1GB, or larger capacity, compact flash card. S&C sup-
plies and recommends the SanDisk Extreme® III CompactFlash® 1GB card. The CF 

card must be formatted as FAT, rather than FAT32 (all cards shipped by S&C have 
been correctly formatted). 

When  compact flash logging is enabled (from the Logging Setup screen or the keypad), 
every historic event generated by the UIM application is written to the Compact Flash, 
even if historic event logging has been stopped for the in-memory event log, or the event 
does not satisfy logging criteria. 

The UIM uses 100 pre-allocated fixed-size files to store historic event data in the compact 
flash, holding a total of over 1,000,000 events. The files are named LOG00.VM, LOG01.
VM…LOG98.VM, LOG99.VM and are of very similar size. The files are continuously reused: 
once Data Logging fills all 100 files, LOG00.VM will be opened again, and new events writ-
ten, starting from the file’s beginning, and replacing the oldest events. This means that 
after all 100 files have been used, at any given moment, one of the files is circular, without 
a fixed beginning.  

NOTE: the number of event entries in a full file is around 14,000 entries, but this is not a 
precise count, and varies slightly for each file. This means that a reused file is likely to 
contain a small amount of very old data at the end. The older events are obvious because 
they are timestamped. 
Sometimes data being stored to a file is interrupted, normally by a power loss or CF removal. 
In this case Data Logging assumes that the file is corrupted, saves it under a unique name 
such as “AABBCCDD.err”, and creates a new file for future use. A corrupted file like this 
can still be useful, because usually only a small amount of data is lost. There is a Special 
Event Counter associated with the saving of a corrupted file, called “CF Data Likely Lost 
on Error,” that can be viewed on the Special Events screen.

CAUTION: do not remove the Compact Flash card when Compact Flash logging 

is active (which can be seen on the “Logging Setup” IntelliLINK screen or on the LCD). 
Doing so may corrupt the card and cause loss of data. Disable compact flash logging first, 
either with IntelliLINK, or with the keypad.
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CF logs cannot be viewed through the IntelliLINK screens. To view a compact flash log, 
the following steps need to be followed:

1. After making sure that Compact Flash logging is disabled, remove the card 
 from the device. 

2. Insert the CF card into a compact flash reader, connected to your PC. You 
 should see LOGXX.VM files in the card’s root directory. 

3. Run IntelliLINK. 

4. Use the File > Open Snapshot IntelliLINK menu to select the compact flash log- 
 ging file that interests you. The “Last Modified” timestamp in the IntelliLINK 
 Open Snapshot File dialog is that of the latest event in the file. Screens will not  
 contain any meaningful data, because the snapshot solely has the CF log in it. 

5. Use Data > Event/Data logs menu of IntelliLINK to open the “Select Log” Dia-
 log. Expand the item in the dialog and choose the “CF Event Log (SNAPSHOT 
 ONLY!)” option. 

6. Click OK and ignore any warnings by clicking OK in the dialogs that appear. 
 You check the “Save To File” checkbox if you want to generate an HTML file on 
 your disk. 

7. The log containing all events, in the CF file you opened as a snapshot, will be 
 displayed in an Internet Explorer window, unless the “Save To File” check box  
 was selected. 

 

The columns in the HTML log table are identical to the columns on the Historic Event 
View screens, with the exception of the Log Level column, which has been added to make 
filtering/sorting more powerful. The HTML file can be opened with Microsoft Excel, or 
copied and pasted into Excel, where it can be rearranged in any way that the spreadsheets 
allow.  

Additional information is included with the HTML file: the application version, and the 
local RTU address and location information from the device that generated the CF file. 

NOTE: Do not manually modify any Compact Flash files generated by the UIM 

application. Reinserting a compact flash card with modified files into the UIM may cause 
parts of the logged data to become unreadable. The only safe modification of UIM-generated 
CF files, that can be performed on a PC, is the deletion of ALL the files, or reformatting 
the card for FAT file system.

Viewing Compact Flash 
Data
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